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Preface

This document describes how to use Spatial Studio on your Autonomous AI Database
Serverless instance.

Audience
This document is intended for data analysts, application developers, and other Oracle Cloud
users who want to administer and use Spatial Studio to visualize and analyze geospatial data.

Related Documents
• Getting Started With Oracle Cloud

• Oracle Spatial Developer's Guide

• Using Oracle Spatial AI on Autonomous AI Database Serverless

• Oracle Machine Learning Notebooks

• Oracle Machine Learning for Python User's Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an action, or
terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which you supply
particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in examples, text
that appears on the screen, or text that you enter.
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1
Get Started Using Spatial Studio

Topics:

• About Oracle Spatial Studio

• Key Terms and Concepts in Spatial Studio

• Explore the Spatial Studio User Interface

• Set Up Spatial Studio Users and Privileges

• Access Spatial Studio

• About the Compute Environment in Spatial Studio

• Typical Workflow for Visualizing Spatial Data

About Oracle Spatial Studio
Oracle Spatial Studio is a web-based interface that enables you to explore, visualize, and
analyze geospatial data on your Autonomous AI Database Serverless instance.

Key features of Spatial Studio include:

• Accessing geospatial data available on Autonomous AI Database and creating different
types of spatial datasets.

• Provisioning a compute environment to meet your requirements for running specific tasks
in Spatial Studio.

• Creating projects to visualize the geospatial data on maps or in tables.

• Publishing a project or embedding the project in an external web application.

• Running spatial analyses on the geospatial data and storing the visualization results.

The following figure shows a sample visualization of a spatial analysis dataset that connects
the starting and ending points on a map layer.
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Key Terms and Concepts in Spatial Studio
Learn the key concepts and terminologies when working with Spatial Studio.

Projects
A project contains datasets, that are logically related to some intended usage. For example, a
project might be named New England Sales Territories, or Sales Territories and Customers, or
Ohio Airports and Counties. When creating a project, you should know the purposes for which
you want to visualize and analyze spatial data in a geographic area. It represents a workspace
that can be saved and reopened.

Datasets
A dataset is a collection of spatial features of a specific usage type and geometry type. For
example, datasets might include Airports represented by polygon geometries, or Roadways
represented by LRS line string geometries, or Accidents represented by point geometries.

Public Dataset
A public dataset is one with a GeoJSON endpoint that can be accessed without having to log
onto the Spatial Studio first. A public dataset is always visible to all the Spatial Studio users
and can be used in their projects.

Published Projects
A published project is a snapshot of the visualizations and analyses that a user has created in
a project. It provides an easy way of sharing what users have created within their organization.

Public Published Project (PPP)
A public published project is a published project where all the datasets involved are public
datasets, and the published project itself is also made public. You can embed the
visualizations of a public published project in other web applications, or can be viewed
standalone in a web browser, without having to log onto Spatial Studio server first.

Analysis
An analysis is typically one or more (spatial) operations performed on one or more datasets.
The operation types and their parameters for an analysis are all stored as part of a project.
The result of any analysis can be visualized, just like any other dataset.

Explore the Spatial Studio User Interface
Explore and learn about the interactive Spatial Studio user interface.

Using the main Spatial Studio user interface, you can create one or more projects, each of
which can define one or more spatial datasets on which you can perform various spatial
operations.

The main landing page for Spatial Studio is as shown:

Chapter 1
Key Terms and Concepts in Spatial Studio
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The overall layout of the Spatial Studio user interface comprises the following:

• Header: The header at the top of the page contains the following buttons:

– : To display or hide the side navigation menu.

– : Displays the status of the compute environment.

–  : To help you get started on Spatial Studio by providing an overview of the tool and
links to other tutorial resources.

– : Displays the user profile details.

• Side Navigation Menu: A navigation panel on the left displays the menu items. You can
expand or collapse the navigation drawer.
The navigation menu consists of the following options:

– Active Project: Directs you to the Active Project page where your recent working
project is displayed. See Overview of Active Project Page for more information.

– Projects: Directs you to the Projects page where you can view your existing projects
(and published projects) or create a new project. See Overview of Projects Page for
more information.

– AI Labeling: Directs you the AI Labeling page where you can define and add labels to
AI labeling projects. See Overview of AI Labeling Page for more information.

– Datasets: Directs you to the Datasets page where you can view the existing datasets
or create a new dataset. See Overview of Datasets Page for more information.

– Connections: Directs you to the Connections page where you can view the existing
connections (data sources) or create a new connection. See Overview of Connections
Page for more information.

– Jobs: Directs you to the Jobs page where the various background jobs started by
Spatial Studio to process various requests are listed. See Overview Jobs Page for
more information.

– Console: Directs you to the Console page where the Spatial Studio administrator can
monitor the status and activity of Spatial Studio. It contains tabs for Settings,
Maintenance, and Monitoring. See Overview of Console Page for more information.

• User Workspace: The page specific details for the selected menu option is displayed on
the right.

Chapter 1
Explore the Spatial Studio User Interface
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Set Up Spatial Studio Users and Privileges
Learn about creating and assigning privileges for Spatial Studio users.

Perform the following steps to set up a Spatial Studio user with the correct set of roles and
privileges using Oracle Database Actions:

1. Sign in to Oracle Cloud and navigate to your Oracle Autonomous AI Database instance.

2. Access Database Actions from the Oracle Cloud Infrastructure Console as an ADMIN user.

See Access Database Actions as ADMIN for more information.

3. Click Database Users in the Launchpad page under the Administration group.

4. Click Create User on the Database Users page, in the All Users area.

The Create User slider opens and displays the Users tab by default.

5. Enter User Name and Password, then re-enter the password to confirm.

6. Select a quota from the Quota on tablespace DATA drop-down.

7. Click the Granted Roles tab and grant the required Spatial Studio role to the database
user.

Search for the required role that you wish to grant. Supported Spatial Studio roles are:
SPATIAL_ADMIN, SPATIAL_AUTHOR, and SPATIAL_CONSUMER.
See About Spatial Studio User Roles for more information on the different roles supported
in Spatial Studio.

Note that if the database user is not assigned any Spatial Studio user role, then the user is
considered a read-only (SPATIAL_CONSUMER) user and can perform only limited actions in
Spatial Studio. See Read-Only User: SPATIAL_CONSUMER for more information.

8. Click Create User to set up the new user in the database.

9. Navigate to the SQL page in Database Actions.

See The SQL Page for more information.

10. Grant the appropriate privileges based on the Spatial Studio role assigned to the database
user in step 7.

• SPATIAL_ADMIN or SPATIAL_AUTHOR

GRANT CREATE SESSION, CREATE TABLE, CREATE VIEW, CREATE SEQUENCE, 
CREATE PROCEDURE, CREATE TYPE, CREATE SYNONYM, CREATE TRIGGER TO 
<db_user>;

• SPATIAL_CONSUMER

GRANT CREATE SESSION, CREATE TABLE, CREATE VIEW TO <db_user>;

11. Grant the database user connect to Spatial Studio through a proxy user as shown.

ALTER USER <db_user> GRANT CONNECT THROUGH "SPATIAL$PROXY_USER";

The database user is set with all the required privileges and can now log into Spatial
Studio.

Chapter 1
Set Up Spatial Studio Users and Privileges
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About Spatial Studio User Roles
Learn about the different user roles supported in Spatial Studio.

The following application roles are supported in Spatial Studio:

• SPATIAL_ADMIN

• SPATIAL_AUTHOR

• SPATIAL_CONSUMER

It is important to note that all the role names are case sensitive. When granted to a user, these
roles allow the user to access the various features and services of Spatial Studio, governed by
the rules described in the following sections.

Administrator: SPATIAL_ADMIN
A user with the SPATIAL_ADMIN role is considered the system-level administrator of the
accessed Spatial Studio instance, irrespective of all other roles they may hold.

A user with a system-level administrator role is not recommended for performing regular
development or analysis work while inside Spatial Studio. An admin user’s responsibilities are
the following:

• Change global or instance-wide settings such as banner customization, custom base maps
or safe domains.

• Monitor and view system logs if your Spatial Studio instance is connected to a compute
environment.

Regular User: SPATIAL_AUTHOR
A user with role SPATIAL_AUTHOR (but not SPATIAL_ADMIN) is considered a regular user.

A regular user role allows the user to:

• Create various Spatial Studio objects such as connections, datasets, and projects.

• Create spatial analyses.

• Publish projects and add custom map icons.

Read-Only User: SPATIAL_CONSUMER
A user with the SPATIAL_CONSUMER role is considered a read-only user and is prohibited from
creating, modifying or removing any permanent objects (such as datasets, connections, spatial
analyses, write-access tokens, and so on) within Spatial Studio.

A user with the SPATIAL_CONSUMER role is allowed to:

• Create a new project from existing datasets.
However, the new project cannot be saved or published.

• Perform data visualization activities within the currently logged in session.

Chapter 1
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Note

A user is a read-only user if SPATIAL_CONSUMER is the only role granted to them. If a
user has both SPATIAL_CONSUMER and any other role (such as SPATIAL_AUTHOR), then
those other roles with greater privileges will take precedence.

The following describes a few use cases that apply for the SPATIAL_CONSUMER role:

• As seen in Regular User: SPATIAL_AUTHOR, a user with SPATIAL_AUTHOR role can create
projects and datasets within Spatial Studio. Once the project(s) are finalized, the Spatial
Studio administrator may change the user's role to contain only SPATIAL_CONSUMER,
effectively freezing the projects from being modified (accidentally).

• Another use case of such a role is for read-only users to be able to visualize publicly
available datasets for information purposes without creating permanent projects that can
potentially consume a lot of resources in Spatial Studio.

Access Spatial Studio
You can access Spatial Studio on your Autonomous AI Database Serverless instance either
from the Oracle Cloud Infrastructure console or with Database Actions.

Topics:

• Access Spatial Studio Using Oracle Cloud Infrastructure Console

• Access Spatial Studio Using Database Actions

Access Spatial Studio Using Oracle Cloud Infrastructure Console
Perform the following steps to access Spatial Studio from Oracle Cloud Infrastructure console:

1. Sign in to Oracle Cloud.

2. Select an Autonomous AI Database Serverless instance.

This opens the Autonomous AI Database details page.

3. Select the Tool configuration tab on the Autonomous AI Database details page.

4. Copy the Public access URL for Spatial Studio.

Spatial Studio access URL gets copied to the clipboard.

5. Paste the URL in your browser to launch the application.

Note

If you are already logged in to a built-in tool with single sign-on on your
Autonomous AI Database instance, you can access Spatial Studio directly without
entering your login credentials.

The login screen opens.

6. Enter your Username and Password and then click Sign In.

See Set Up Spatial Studio Users and Privileges for information on how to set up a Spatial
Studio user with the required privileges.

Chapter 1
Access Spatial Studio
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You are now connected to Oracle Autonomous AI Database using Spatial Studio.

Access Spatial Studio Using Database Actions
1. Sign in to Oracle Cloud and select an Autonomous AI Database instance.

This opens the Autonomous AI Database details page.

2. Click View all database actions in the Database actions drop-down list.

3. Click Spatial Studio in the Development tab.

A few built-in tools on your Autonomous AI Database instance (such as Database Actions,
Oracle APEX, Graph Studio, Spatial Studio, and so on) can be accessed from Database
Actions through single sign-on. See Access Built-in Tools from Database Actions with
Single Sign-on for more information.

Therefore, if you are already logged in to a built-in tool with single sign-on, you can access
Spatial Studio directly without entering your login credentials.

Otherwise, the Spatial Studio login screen opens in a new tab.

4. Enter Username and Password and then click Sign In.

See Set Up Spatial Studio Users and Privileges for more information on how to set up a
Spatial Studio user with the required privileges.
You are now connected to Oracle Autonomous AI Database using Spatial Studio.

About the Compute Environment in Spatial Studio
You can provision a dedicated compute environment to run Spatial Studio.

By default, Spatial Studio runs using resources that are automatically allocated through the
Oracle Cloud Infrastructure (OCI) Control Plane on your Autonomous AI Database instance.
You can perform most of the typical activities such as uploading a shapefile (less than 50 MB),
geocoding a small dataset, or creating map visualizations, using these shared resources.
However, they may not be sufficient in certain scenarios, such as the following:

• Uploading images for GeoRaster datasets

• Uploading large files exceeding 50MB

• Geocoding tables with more than 500 records

• Using the Spatial AI labeling function

In such cases, Spatial Studio can be attached to a newly created compute environment with
greater compute power and memory. The compute environment is shared by all users of your
Autonomous Database Serverless instance. Any user can create the compute environment;
however, only the Spatial Studio administrator can detach it. Detaching the compute
environment terminates all active user sessions connected to that environment.

Note

You are billed by the hour when running Spatial Studio on a newly created compute
environment. For instance, if you use the compute environment for only 15 minutes
and then terminate it, you will still be charged for a full hour.

Chapter 1
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The status in the application header (top right) indicates whether Spatial Studio is attached to a
compute environment. The compute environment can be available in one of the following
states:

• Detached (default): Spatial Studio is not attached to a compute environment.

• Attached: Spatial Studio is attached to a compute environment.

• Attaching: Spatial Studio is in the process of attaching to a compute environment.

Related Topics

• Create a Compute Environment
You can configure a new compute environment in Spatial Studio.

Typical Workflow for Visualizing Spatial Data
Learn the workflow to visualize and analyze spatial data using Spatial Studio on Autonomous
AI Database Serverless instance.

Task More Information

Create an Autonomous AI Database Serverless
instance from Oracle Cloud Infrastructure console.

Provision Autonomous Database

Create Spatial Studio users and grant the
necessary roles and privileges.

Set Up Spatial Studio Users and Privileges

Access the Spatial Studio Application Access Spatial Studio

Review if your task requires setting up a dedicated
compute environment.

• About the Compute Environment in Spatial
Studio

• Create a Compute Environment (if required)

Create a dataset using your geospatial data in
Spatial Studio.

Work with Datasets

Create a project and add the dataset. Work with Projects

Visualize the spatial dataset on a map.
Optionally, style the map layer as desired.

Work with Visualization
Style a Map Layer

Run spatial analysis and visualize the results. Run Spatial Analyses

Chapter 1
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2
Work with Projects

You can view all the projects ( both published and unpublished) that were created in Spatial
Studio on the Project page. The Active Project page displays your current working project.

Topics:

• Overview of Projects Page

• Overview of Active Project Page

Overview of Projects Page
The layout of the project page is as shown:

The Projects page comprises two tabs:

• Projects: Displays the list of projects created in Spatial Studio.

• Published projects: Displays the list of published projects.

You can perform the following actions on the Projects page:

• You can select and view a project or published project in the respective tabs.

• You can create a new project by clicking Create Project.

• You can import a project by clicking Import and selecting a project zip file in the Import
Project dialog.

• You can alter the display settings to have the projects listed as cards or in a tabular format
in the respective tabs.

• You can search for both unpublished and published projects and view the search results in
the respective tabs.
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• You can filter to view projects that are either created by you, or shared with you, or both in
the respective tabs.

• You can open, export or delete a project in the Projects tab by clicking the  icon for
any of the listed projects. For the first two actions, the project will be opened in the Active
Project page.

• See About Published Projects for the actions supported on published projects.

Overview of Active Project Page
The Active Project page displays your current working project. However, you can switch to your
working project at any time from the other pages when working in Spatial Studio.

The following figure shows a layout of the Active Project page:

You can perform the following actions on the Active Project page:

• Creating a table or map visualization.

• Adding or removing datasets from your project.

• Adding or removing data from a visualization layer.

• Organizing the Layers List panel to be arranged vertically below or to the right of the
project Data and Visualizations panel using the icons shown highlighted in the preceding
figure.

• Adjusting the style setting or the zoom resolution for your visualization layer. You can click
the menu selector next to the map layer in the Layers tab to display the following available
options:

– Settings: Shows display options for Style, Filter, Interaction, and Legend.

– Spatial Analysis: Allows you to perform many spatial operations (All, or filtered by
type: Filter, Combine, Transform, Measure), such as Add a buffer of a specified
distance, Return shapes having spatial relationship to another, and Calculate area.

– Zoom to Layer: Zooms the display (out or in) to fit the entire layer.

– Refresh Layer: Refreshes the layer to reflect all user actions.

– Configure Animation: Allows you to configure animation settings to visualize a
moving object.

– Remove: Removes the layer from the project.
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• Using the project management options displayed on the top-right area of the Active Project
page:

– Actions: The drop-down menu allows you to:

* Save Project as: Creates a new copy of the project.

* Publish Project: Publishes the project.

* Edit: Allows you to edit the project details (such as, Name, Created By and
Description).

– Save: Saves your updates to the project.

– Close: Closes the project.

• Using the map tool bar options on the top right of the map visualization pane:

– : The Actions drop-down menu allows you to:

* Create Custom Region: Creates custom region for the selected polygons.

* Save Selections: Saves selected features on the map layer to a dataset.

* Save Pins: Saves the pins dropped on a map layer to a dataset.

– : Search based on address, latitude or longitude.

– : The Measure Menu allows you to measure liner or radial distances.

– : The Select By Shape drop-down menu allows you to make a rectangular,
circular, or a polygonal selection.

– : The Clear Menu allows you to clear selections, pins, tool drawings, or all.

– : Refresh Layers allows you to refresh the map layers.

– : Settings allows you to configure your visualization settings.

– : Delete icon allows you to remove the map visualization from the project.

About Published Projects
You can share your Spatial Studio project with other users by publishing it.

Once your project is completed on the Active Project page, then you can save and publish the
project. The published project gets displayed on the Projects page in the Published projects
tab.

You can perform the following actions on a published project:

• Open: Opens the project.

• URL: Provides the URL for the published project. You can use the URL to embed the
project in an external web application through iFrames.
However, note that this is typically only used for published projects that contain only public
datasets. A public published project can be accessed through its URL by any user on the
internet without logging into the Spatial Studio application.

• Sync with source project: Keeps the project synchronized with the source.
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• Permissions: Allows you to make a published project public (or private if it is already
public).
Note that this option will be enabled only if all the datasets that are in the published project
themselves are already public. In such cases, you may choose to use the Permissions
option to make the published project itself also be public.

• Edit: Allows you to edit the project name and description.

• Delete: Deletes the published project.
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3
Work with AI Labeling

You can use Oracle Spatial Studio to label data for AI tasks and to leverage Spatial AI
geospatial raster analysis and modeling capabilities.

Note

Spatial Studio needs to be attached to a compute environment for AI Labeling. See 
Create a Compute Environment for more information.

Topics:

• About AI Labeling

• Overview of AI Labeling Page

• Get Started with AI Labeling

About AI Labeling
Learn about AI Labeling in Oracle Spatial Studio on Autonomous AI Database.

Topics:

• What is AI Labeling

• Key Concepts in AI Labeling

What is AI Labeling
AI Labeling in Oracle Spatial Studio prepares training data for deep learning by creating and
managing labels directly on geospatial raster data, including airborne photos, satellite imagery,
and any other gridded data.

Geospatial rasters are sourced from GeoRaster objects in Oracle Spatial Database or from
geospatial imagery stored in Oracle Cloud Infrastructure (OCI) Object Storage. They are
presented to the user as geospatial raster chips for labeling. Chips are raster tiles appropriate
for training deep learning models, usually small in size. AI Labeling supports both
georeferenced and non-georeferenced geospatial rasters.

AI Labeling supports the complete data preparation workflow for Spatial AI. It also includes:

• Manual labeling of geospatial raster chips to mark features such as buildings, roads, or
vegetation.

• Loading labels from supported formats (for example, GeoJSON, YOLO, or mask images).

• Storing labels and their corresponding raster chips in Autonomous AI Database, OCI
Object Storage, or locally, to continue the workflow directly in Spatial AI.

• Auto-labeling using geometry features either from Oracle Spatial databases or from
Oracle-managed geometry data, which maps physical features on the ground.

Using Oracle Spatial Studio on Autonomous AI Database
G40399-01
Copyright © 2021, 2026, Oracle and/or its affiliates.

April 10, 2026
Page 1 of 22



These capabilities make Spatial Studio the primary tool for preparing labeled geospatial raster
datasets for use in Spatial AI to train new models or apply transfer learning on existing models
with additional data.

AI Labeling in Spatial Studio is typically used in the following scenarios:

• To automatically generate initial labels through auto-labeling, followed by manual review
and edit.

• To manually prepare training datasets by labeling geospatial raster chips or refining auto-
labeled results.

• To leverage existing label data by loading labels from supported formats.

• To continue the AI workflow by storing labels in the database, OCI Object Storage, or local
files for use in Spatial AI.

Key Concepts in AI Labeling
Oracle Spatial Studio provides a labeling environment that integrates tightly with Spatial AI for
preparing geospatial raster data for deep learning.

This section introduces key concepts used in AI Labeling.

Geospatial Raster
A geospatial raster is an image composed of a grid of pixels, each tied to a specific location on
the Earth’s surface. In AI Labeling, geospatial rasters are the raw input for deep learning
workflows. They may be georeferenced (tied to real-world coordinates) or non-georeferenced
(treated as plain images).
Also, note that:

• Geospatial rasters stored in OCI Object Storage are accessed as collections of raster
chips, each chip being a separate image used for labeling.

• Large geospatial rasters stored as GeoRaster objects in Oracle Spatial can be split into
chips when creating a project in Spatial Studio, where the user defines the chip size for
labeling and deep learning processing.

Chip
A chip is a smaller portion of a geospatial raster image and the basic unit of work in AI
Labeling. Chips make it possible to apply machine learning and deep learning techniques to
very large geospatial rasters by dividing them into manageable pieces.
In Spatial Studio, users label chips directly. These labeled chips provide the training data for
deep learning models.

Label
A label assigns semantic meaning to geospatial raster data. In AI Labeling, labels can be:

• Feature-based: Attached to specific regions in a chip, such as buildings, roads, or
vegetation.

• Chip-based: Applied to the entire chip, used for image classification (for example,
labeling a chip as urban, forest, or water).

Labels are the ground truth used to train machine learning and deep learning models. They
can be created manually in Spatial Studio, imported in supported formats, or generated
automatically.
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Auto-labeling
Auto-labeling is the process of automatically generating labels without manual drawing. It uses
known features from maps to label geospatial raster chips. In Spatial Studio, auto-labeling can
be performed in two ways:

• Auto-labeling with Oracle-managed data: Uses an Oracle-managed set of supported
feature types (such as buildings or water). These features are mapped to the label
categories defined in the project.

• Auto-labeling with user-managed data: Uses user-managed data containing
SDO_GEOMETRY objects (that is, features) to generate labels aligned with geospatial
raster chips.

Labeling Types
AI Labeling in Spatial Studio supports different labeling types, depending on the machine
learning or deep learning task:
Image Classification
A single label is applied to an entire geospatial raster chip (for example, urban, forest, water).
Object Detection
Labels are applied to bounding boxes that mark the location and type of objects within a
geospatial raster chip (for example, detecting buildings or vehicles).
Semantic Segmentation
Labels are applied at the pixel level, assigning each pixel in a geospatial raster chip to a
category (for example, distinguishing between vegetation, road, and water areas).
Sparse Labeling (variant of Semantic Segmentation)
Instead of labeling all pixels, only a subset of pixels is labeled across the geospatial raster
chip (for example, annotating key sample points of roads or vegetation). This approach
reduces annotation effort while still guiding model training.
Instance Segmentation
Similar to semantic segmentation, but separates individual objects of the same category (for
example, labeling multiple distinct trees within the same chip).

Nested Labels (Object Detection & Instance Segmentation)
For the project types discussed under Labeling Types, it is also possible to assign additional
labels or attributes per instance. For example, in instance segmentation of buildings, each
building polygon can include nested information such as height, usage, or other classification
labels. This extends the concept of image classification to the level of individual detected
objects.

Overview of AI Labeling Page
The AI Labeling page allows you to create AI labeling projects, label chips, load and store
labels, and share your AI labeling project with other users.

Note

Spatial Studio needs to be attached to a compute environment for AI Labeling. See 
Create a Compute Environment for more information.

The page displays all the AI Labeling projects created in your Spatial Studio instance:

 

Chapter 3
Overview of AI Labeling Page

Using Oracle Spatial Studio on Autonomous AI Database
G40399-01
Copyright © 2021, 2026, Oracle and/or its affiliates.

April 10, 2026
Page 3 of 22



 

You can perform the following actions on the AI Labeling page:

• You can create a new AI Labeling project, by clicking Create Project.

• You can filter to view projects that are either created by you, or shared with you, or both.

• You can perform the following actions by clicking  against any displayed project :

– Go to labeling: Label chips within a project (see Create Labels Manually and Create
Labels with Auto-Label).

– Edit project: Edit an existing AI Labeling project.

– Load labels: Load labels into your project (see Load AI Labels).

– Store project: Store the entire project (see Store AI Labels).

– Permissions: Configure project sharing and permissions (see Sharing an AI Labeling
Project).

– Delete: Delete a project.

Get Started with AI Labeling
Learn to work with AI Labeling in Oracle Spatial Studio.

Topics:

• Prepare for AI Labeling

• Create an AI Labeling Project

• Create Labels Within an AI Labeling Project

• Store AI Labels

• Sharing an AI Labeling Project

Prepare for AI Labeling
Learn the prerequisite tasks required for creating an AI Labeling project.

1. Ensure that you have geospatial raster chips available for labeling on the Datasets page in
Spatial Studio.

GeoRaster datasets containing imagery can be created from one of the following options:

• Oracle Spatial GeoRaster Database:

– Create a Dataset by Loading Raster Images into Oracle Spatial GeoRaster
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– Create a GeoRaster Dataset

• Oracle Cloud Infrastructure (OCI) Object Storage: Create a Dataset Using a Pre-
Authenticated Request URL

2. Define labels in Spatial Studio.

a. Navigate to the AI Labeling page.

b. Click Define Labels.

The Define Labels page opens where you can view the existing labels or add a new
label. For example:
 

 

c. Click Add to create a label definition.

The Add Labels slider opens as shown:
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d. Enter the Label Name, Description, and click Next.

e. Select a Labeling task type from the drop-down and define the labels.

The supported AI Labeling task values are as shown:

• Image Classification: Add one or more instructions as required. For example:
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• Object Detection: Enter a Label Name and Label color. Optionally, add nested
labels. For example:
 

 

• Semantic Segmentation: Enter a Label Name and Labeling color. For example:
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• Instance Segmentation: Enter a Label Name and Labeling color. Optionally,
add nested labels. For example:
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f. Click Add.

The label gets added and listed on the Define Labels page.

Create an AI Labeling Project
You can create an AI Labeling project in Spatial Studio using defined labels.

Ensure that you meet all the prerequisites as described in Prepare for AI Labeling.
Perform the following steps to create an AI Labeling project:

1. Navigate to the AI Labeling page.

2. Click Create Project.

The Create Project slider opens as shown:
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3. Enter the project Name and optionally, Description.

4. Select the GeoRaster Dataset from the drop-down.

Note the following about the datasets:

• For a GeoRaster dataset created from Oracle Spatial GeoRaster database, you need
to specify the chip size to control how the geospatial raster is split into chips for
labeling.

• For a GeoRaster dataset created from OCI Object Storage, chips are provided as part
of the dataset. They may include georeferencing through embedded formats
(GeoTIFF) or a world file.

• Both the preceding dataset types can be georeferenced or non-georeferenced.

5. Select a label from the Labels drop-down.

6. Configure the geospatial raster display.
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a. Select the bands for RGB rendering (default: bands 1, 2, and 3).

b. Optionally, apply normalization or enhancement functions from the Color balance
drop-down.

The supported values are:

• Automatic linear stretch

• Manual linear stretch

• Piecewise linear stretch

• Normalization

• Equalization

c. Optionally, specify the Image chip size (Width and Height) if you are using a
GeoRaster dataset created from Oracle Spatial GeoRaster database.

7. Click Create Project.

The project gets created and is shown listed on the AI Labeling page.

Create Labels Within an AI Labeling Project
You can add labels to GeoRaster image chips within an AI Labeling project.

You can label chips using one of the following options.

Topics:

• Create Labels Manually

• Create Labels with Auto-Label

• Load AI Labels

Create Labels Manually
You can add labels to chips manually in Spatial Studio.

Perform the following steps to manually label a chip.

The following instructions assume that an AI Labeling project created using a dataset
containing multiple image chips exists in Spatial Studio. Also, the related label to be applied
onto the chips is already defined (see Prepare for AI Labeling).

1. Navigate to the AI Labeling page.

The page displays all the AI Labeling projects created in your Spatial Studio instance.

2. Click to open the project you wish to start labeling.

Alternatively, click  against the desired project and select Go to labeling.
The project opens displaying the first chip in the dataset. For example:
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3. Click View all images (at the bottom of the page) to review the chips in the dataset.

Note that you can logically delete or restore the chips within the project.

4. Select the chip for labeling and go back to the labeling page.

5. Label the chip manually as shown:

a. Perform the following step depending on your project type.

• Object Detection: Click + next to the label name (on the right side of the page) to
create a new instance. Labels are created, moved, resized, and deleted using
bounding boxes.

• Instance Segmentation: Click + next to the label name (on the right side of the
page) to create a new instance. The drawing tools (Brush, Polygon, Eraser) for
manual labeling appear at the top of the chip.

• Semantic Segmentation: The drawing tools (Brush, Polygon, Fill Color, Eraser) are
available without creating instances.

b. Choose the tool of your choice and manually mark the chip for labeling.

For example the following image shows three labeling instances - two using polygons
and one using brush on a chip that belongs to an AI Labeling project of type Instance
Segmentation.
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6. Click Save to store the labels along with the other Spatial Studio data in the database.

7. Repeat step-3 to step-6 for all the required chips in the project.

Create Labels with Auto-Label
Spatial Studio allows you to automatically generate labels from existing data instead of drawing
them manually.

Auto-labeling provides an initial set of annotations for geospatial raster chips that can then be
reviewed and refined manually.

Note

Auto-labeling is supported for georeferenced projects of type Object Detection,
Semantic Segmentation, and Instance Segmentation only.

Topics:

• Auto-Label with Oracle-Managed Feature Data

• Auto-Label with User-Managed Geometry Data

Auto-Label with Oracle-Managed Feature Data
You can label chips within an AI Labeling project using Oracle-managed geometry data to
automatically detect physical features in geospatial raster chips.

Category pairing is applied by pairing each project label category (for example, building, road,
water) with a corresponding Oracle-managed feature type.

To auto-label chips, ensure that the project uses geo-referenced spatial data either in a geo
format (for example, GeoTIFF) or with the corresponding world file.

The following instructions assume that an AI Labeling project created using a dataset
containing multiple image chips exists in Spatial Studio.

1. Navigate to the AI Labeling page.
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The page displays all the AI Labeling projects created in your Spatial Studio instance.

2. Click to open the project you wish to start labeling.

Alternatively, click  against the desired project and select Go to labeling.
The project opens displaying the first chip in the dataset.

3. Click View all images (at the bottom of the page) to review the chips in the dataset.

Note that you can logically delete or restore the chips within the project.

4. Select the chip for labeling and go back to the labeling page.

The Auto-labeling tag gets enabled at the top of the chip (shown highlighted in the
following figure).

5. Click Auto-labeling.

The Configure auto-labeling workflow opens and displays the Define auto-labeling step
as shown:
 

 

6. Select Oracle-managed data from the Label dataset drop-down.

7. Click Add Oracle Maps feature.

8. Select the Key and Values from the drop-downs.

You can repeat this step to add as many labels.

9. Optionally, configure the Minimum geometry area and Minimum query box area under
Advanced Settings.

Note the following:

• Minimum Geometry Area: For geometries partially outside the chip bounding box, the
system calculates the percentage of the geometry’s area that remains inside. If the
percentage is less than the specified value, the geometry is ignored.

• Minimum Query Box Area: For each geometry, the system calculates the percentage
of the chip bounding box covered by the geometry. If the percentage is less than the
specified value, the geometry is ignored.

10. Click Next.

The Choose images step opens and displays all the chips in the project along with their
labeling status.
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11. Select one or more chips which you wish to label.

12. Click Start auto-labeling.

Once the process completes the labeling status will get displayed as Finished.

13. Click Close.

The chip(s) get auto-labeled as shown:
 

 

Auto-Label with User-Managed Geometry Data
You can label chips within an AI Labeling project with user-managed datasets containing
SDO_GEOMETRY objects in the Oracle Spatial database.

Geometries are matched against geospatial raster chips, and labels are created where
geometries overlap chips.

• Category pairing is applied by pairing each project label category (for example, building)
with a dataset column that stores SDO_GEOMETRY objects of that type.

• If you have GeoJSON or Shapefiles, these must first be uploaded into a Spatial Studio
dataset; once imported, they can then be used for geometry-based auto-labeling.

To auto-label chips, ensure that the project uses geo-referenced spatial data either in a geo
format (for example, GeoTIFF) or with the corresponding world file.

The following instructions assume that an AI Labeling project created using a dataset
containing multiple image chips exists in Spatial Studio.

1. Navigate to the AI Labeling page.

The page displays all the AI Labeling projects created in your Spatial Studio instance.

2. Click to open the project you wish to start labeling.

Alternatively, click  against the desired project and select Go to labeling.
The project opens displaying the first chip in the dataset.

3. Click View all images (at the bottom of the page) to review the chips in the dataset.
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Note that you can logically delete or restore the chips within the project.

4. Select the chip for labeling and go back to the labeling page.

The Auto-labeling tag gets enabled at the top of the chip.

5. Click Auto-labeling.

The Configure auto-labeling workflow opens and displays the Define auto-labeling step:
 

 

6. Select the dataset from the Label dataset drop-down.

7. Select the Geometry column name.

8. Optionally, configure the Minimum geometry area and Minimum query box area under
Advanced Settings.

Note the following:

• Minimum Geometry Area: For geometries partially outside the chip bounding box, the
system calculates the percentage of the geometry’s area that remains inside. If the
percentage is less than the specified value, the geometry is ignored.

• Minimum Query Box Area: For each geometry, the system calculates the percentage
of the chip bounding box covered by the geometry. If the percentage is less than the
specified value, the geometry is ignored.

9. Click Next.

The Choose images step opens and displays all the chips in the project along with their
labeling status.

10. Select one or more chips which you wish to label.

11. Click Start auto-labeling.

Once the process completes the labeling status gets displayed as Finished.

12. Click Close.

The chip(s) get auto-labeled as shown:
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Load AI Labels
You can load existing labels into your AI Labeling project.

You can upload individual files or a ZIP file. Individual files are usually recommended because
they show more precise errors, for example, when only a few label files have formatting issues
or need correction. When uploading a zip file, ensure that all the individual files are placed in
the root folder, without subfolders.

The following file formats are supported for the labeling types (both uppercase and lowercase
extensions are accepted):

• Object detection: JSON (.json), GeoJSON (.geojson), Shapefile
(.shp/.shx/.dbf/.prj), Pascal VOC (.xml), and YOLO (.txt)

• Instance segmentation: JSON, GeoJSON, and Shapefile

• Semantic segmentation: .png, .tiff, .geotiff, .gif, .bmp, .jpg, and .jpeg

It is important to note that the labels are matched to chips by name (for example, chip_0123.*
→ chip_0123). Use a single label source per chip. For mask files, image dimensions must
match the target chip.

Perform the following steps to load labels into an AI Labeling project.

1. Navigate to the AI Labeling page.

2. Click  against the desired project and select Load labels.

Alternatively, click open the project and select Load Labels from the Action menu.
The Load labels window opens as shown:
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3. Click to upload the file (or through dragging and dropping the file) from your local system.

4. Click Load.

5. Click Close.

Labeling is applied to all the chips that are impacted by the loaded label. The following
figure shows an example of a chip labeling through a loaded label. The chip belongs to an
AI Labeling project of type object detection.
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Store AI Labels
Spatial Studio allows you to store the entire AI project or only the current chip.

The files can be stored in the database, Oracle Cloud Infrastructure (OCI) Object Storage, or
the local system. They can be further used to continue the workflow in Spatial AI or used
externally.

The stored file contains the following:

• Labels in the selected format(s).
The following file formats are supported for the labeling types (both uppercase and
lowercase extensions are accepted).

– Object detection: JSON (.json), GeoJSON (.geojson), Shapefile
(.shp/.shx/.dbf/.prj), Pascal VOC (.xml), COCO, KITTI, and YOLO (.txt)

– Instance segmentation: JSON and COCO

– Semantic segmentation: .png, .tiff, .geotiff, .gif, and .bmp

• Geospatial raster chips for the stored scope:

– Database: Chips are stored as GeoRaster. If the project produces mask labels
(semantic segmentation), those masks are also stored as GeoRaster.

– Object Store and Local file: Chips are stored as-is. If a chip used a world file for
georeferencing, it is stored as a GeoTIFF with embedded georeferencing.

Also, note the following:

• Chips that are logically deleted are excluded.

• Chips without labels are excluded unless explicitly saved with an empty label.

Perform the following steps to store an entire project or a chip only from an AI Labeling project.

1. Navigate to the AI Labeling page.

2. Click  against the desired project and select Store Project to store all the labeled
project chips.
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Alternatively, click open the project and choose Store project or Store current labeled
chip as desired from the Store menu (at the top of the page).
Depending on your choice, the Store project or Store current labeled chip window
opens. For example:

 

 

3. Select the storage Destination.

4. Perform the following related steps depending on your choice in the preceding step.

• Database:

a. Select the required Connection.

b. Enter the Table name.

c. Select the export Format.

• Local file: Select the storage Format.

• Object store (OCI Object Storage):
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a. Enter the PAR URL.
To store in OCI Object Storage you require a Pre-Authenticated Request (PAR)
URL created with access type Permit object reads and writes to those with the
specified prefix.

b. Enter the Prefix for the objects.

c. Select the storage Format.

5. Click Store.

The files is stored in the target destination.

Sharing an AI Labeling Project
You can share your AI Labeling projects with other users in Spatial Studio.

When a project is made public, multiple users can work on the same dataset and labels
collaboratively. This enables team-based labeling workflows and ensures all results are stored
in a single shared project. However, ensure that the dataset referenced by the project is also
public to share your project.

Perform the following steps to share your AI Labeling project.

1. Navigate to the AI Labeling page.

2. Click  against the desired project and select Permissions.

The Sharing and Permissions window opens.

3. Select the Public checkbox.

4. Click OK.

See About Published Projects for the actions that are supported on published projects.
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4
Work with Datasets

You can create, edit, and delete datasets in Spatial Studio on the Datasets page.

Topics:

• Overview of Datasets Page

• Create a Dataset on Datasets Page

• Generate a Spatial Analysis Dataset

• Manage Datasets

Overview of Datasets Page
The Datasets page lets you view and edit existing datasets, and also create new ones.

The following figure shows the Datasets page:

Datasets that are displayed on the Datasets page belong to one of the following two
categories:

• Manually created by clicking Create Dataset or when you perform a Save as operation
with the Create Dataset option enabled. This dataset can then be added to the project for
visualization.

• Automatically created when you perform spatial analysis, save selected features, or store
pins as a map layer.
This dataset gets instantly added to the map visualization and also appears listed in the
Datasets page. Such a dataset is known as a spatial analysis dataset.

You can perform the following actions on the Datasets page:

• You can manually create a new dataset, by clicking Create Dataset.

• You can filter to view datasets that are either created by you, or shared with you, or both.

• By clicking  against any displayed dataset or by right-clicking a dataset row, you can
perform the following actions:

– Properties: View or modify properties of the dataset
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– Update Statistics: Update the dataset statistics (refer to Update Statistics for
Datasets)

– Create Project: Create a new project using the dataset

– Add to Active Project: Add the dataset to the project in the Active Project page

– Export: Export the dataset (in GeoJSON or CSV file format)

– Save as: Make a new copy of the dataset

– Permissions: Configure dataset sharing and permissions

– Cache: Control map tiles pre-caching activities (refer to About Cache in Spatial Studio)

– Prepare: Prepare a dataset for any of the following options:

* Geocode Addresses: Add geocoded information such as geographic coordinates
to the dataset

* Clear Address Geocode: Remove geocoded information from the dataset

* Reverse Geocode: Add address information from a set of geographic coordinates
to the dataset

* Clear Address Reverse Geocode: Remove address information from the dataset

* Create Lat/Lon Index: Create latitude/longitude index

* Drop Lat/Lon Index: Remove latitude/longitude index

* Create H3 Index: Prepare an H3 aggregation dataset

* Join to Spatial Dataset: Prepare a non-spatial dataset for map visualization by
joining to a spatial dataset

* Validate/Fix geometries: Validate the geometries in the dataset and also fixes the
geometries where it is possible for Spatial Studio to do so in an automatic manner.

– Delete: Delete the dataset

Create a Dataset on Datasets Page
Spatial Studio allows you to create datasets using different options from the Datasets page.

The following figure describes the supported options to create a dataset:
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As seen in the preceding figure, you can create a dataset from the following sources:

• Create a Dataset from Database Tables or Views

• Create a GeoJSON URL Dataset

• Create an OGC WMS Dataset

• Create a Dataset Using a Pre-Authenticated Request URL

• Create a Dataset by Uploading a File

• Create a Dataset Using a File URL

• Create a Dataset by Loading Raster Images into Oracle Spatial GeoRaster

The following sections explain in detail the steps to create a dataset using the supported
options:

Create a Dataset from Database Tables or Views
You can create a dataset from tables and views on your Autonomous AI Database instance.

Perform the following steps to create a dataset using the default database connection:

1. Navigate to the Datasets page.

2. Click Create Dataset.

The Create Dataset window opens.
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3. Select the Database table/view option.

4. Select the default connection from the Select Connection drop-down.

5. Click Create.

The Select items to create datasets window opens listing all the tables, views and
GeoRaster data present in the database.

 

 

6. Enter a Dataset name.

7. Select an item from the list and click OK.

Tip

You can also use the Search box to quickly locate your table. This is especially
useful or even necessary if your database connection has many tables, as the
drop-down list only shows up to 500 tables or views.

The new dataset is added and listed on the Datasets page.
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Create a GeoJSON URL Dataset
You can create a dataset by specifying a GeoJSON URL.

It is important to note the following prior to creating a GeoJSON URL dataset:

• A GeoJSON URL based dataset accesses its data directly from the source URL. There is
no database table managed in Spatial Studio for this dataset.

• A GeoJSON URL based dataset does not support Spatial Analysis.

• A GeoJSON URL based dataset is subject to the same upload size limit, or 100MB,
whichever is smaller.

• If a GeoJSON URL does not support CORS (Cross-Origin Resource Sharing), then Spatial
Studio will act as a proxy to the browser requesting the GeoJSON URL data.

Perform the following steps to create a GeoJSON URL dataset:

1. Navigate to the Datasets page.

2. Click Create Dataset.

The Create Dataset window opens.

3. Select the GeoJSON URL option.

4. Specify the GeoJSON URL to access GeoJSON data from an external domain for map
visualization.

Note

Ensure you add the external domain used for accessing GeoJSON data to the list
of entries in the Safe Domains list.

5. Click Create.

Create dataset from GeoJSON window opens.

6. Optionally, enter a Dataset name.

7. Click Submit.

The GeoJSON URL dataset gets created with the warning, No key column was found.
You must resolve the warning in order to use the dataset as a map layer for visualization.

Create an OGC WMS Dataset
Spatial Studio allows you to define datasets that are based on the GetMap responses from any
external OGC (Open Geospatial Consortium) WMS (Web Map Service) services.

Prior to creating a WMS dataset, ensure that the required OGC WMS connection is created in
Spatial Studio.

Perform the following steps to create an OGC WMS dataset:

1. Navigate to the Datasets page.

2. Click Create Dataset.

The Create Dataset window opens.

3. Select OGC Web Map Service.
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4. Select the WMS Connection to be used from the drop-down list.

5. Explore all the available WMS map layers from the external WMS server and select the
required one.

You can Shift+Click to select more than one layer. The external WMS server combines
multiple layers into a single image as a response to Spatial Studio’s requests for the new
WMS dataset.

6. Enter the Dataset name.

7. Click OK.

The OGC WMS dataset gets created and is displayed on the Datasets page.
When this WMS dataset is displayed on a map visualization, Spatial Studio will obtain and
display the images for both the selected layers.

Create a Dataset Using a Pre-Authenticated Request URL
You can create a dataset by specifying the pre-authenticated request (PAR) URL to an object
storage bucket on your Autonomous AI Database instance.

As a prerequisite, ensure that Spatial Studio is attached to a compute environment. See 
Create a Compute Environment for more information.

Perform the following steps to create a PAR URL dataset:

1. Navigate to the Datasets page.

2. Click Create Dataset.

The Create Dataset window opens.

3. Select the OCI pre-authenticated request URL option.

4. Specify the PAR URL to access all the objects in the storage bucket.

5. Click Create.

The Select items to create a dataset opens as shown:
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6. Select the object file(s) for creating the dataset.

For instance, geospatial rasters stored in object storage can be accessed as collections of
tiles. Therefore, you can select all the required image tiles at this step.

7. Click OK.

The dataset get created and is displayed on the Datasets page.
The PAR URL details and the object storage files used for creating the dataset can be
viewed in the Storage token dataset tab in Dataset Properties.

Create a Dataset by Uploading a File
You can create a dataset by uploading a file in a format supported by Spatial Studio.

The supported file formats are as follows:

• Excel file

• Shapefile

• GeoJSON file

• CSV file

• KML file
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Note

Compute environment is required if you are uploading a large file that exceeds 50 MB.
See Create a Compute Environment for more information.

Also, note the following:

• WKT or GeoJSON geometry text values in Excel or CSV files are supported.
If you are uploading a file with WKT text values, then only WKT strings representing
geodetic coordinates (longitude and latitude) are supported.

• Three dimensional coordinates are supported in GeoJSON files.

1. Navigate to the Datasets page.

2. Click Create Dataset.

The Create Dataset window opens.

3. Select the Local File option.

4. Upload any one of the supported file types.

5. Click Create.

The Create Dataset window opens displaying the data columns.

6. Select a value in Upload to connection drop-down.

7. Optionally, review and edit any other parameters as required.

8. Click Submit.

The new dataset gets added and listed on the Datasets page.

Upload a Shapefile
You can create a dataset by uploading a shapefile.

A shapefile contains the geospatial data which can be referenced in multiple files with specific
file extensions. The following lists a few selected files that contribute to shapefile format:

• .shp - Stores the geometry data

• .shx - Stores the index of the geometry

• .dbf - Stores the attribute information of geometry features

• .prj - Stores the coordinate system information

• .cpg - Specifies the character set to be used

Note that shapefiles containing WKT v2 projection files are supported in Spatial Studio.

1. Navigate to the Datasets page and click Create Dataset.

2. Select Local File.

3. Click  to upload the shape file.

The File Upload window opens.

4. Select all the required files from your system.
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Note

It is mandatory to upload .shp, .shx, and .dbf files.

The Create dataset from shapefile dialog opens as shown:

Figure 4-1    Create dataset from shapefile

5. Select the connection to upload the shapefile from the Upload to connection drop-down
list.

6. Optionally, change the Table name.

7. Optionally, change the destination Dataset name.

8. Optionally, select the Coordinate System to be used.

• If your shapefile includes a .prj file referencing a custom Geographic Coordinate
System (GEOGCS), then Spatial Studio will assign a best-matched geodetic SRID
from the target Spatial database, as shown in the preceding figure.

• If your shapefile does not contain a .prj file, then the system uses the default
EPSG:4326 GEOGCS.

9. Optionally, select the required Character set.

Spatial Studio automatically detects the character set to be used in the following order of
priority:

• Extracts the charset-name from a .cpg file, if present.

• Uses the character set specified in the .dbf file header.

• Otherwise, uses the default ISO-8859-1.

You can preview the file attributes using the detected character set. However, you can still
choose to switch to a different Character set and preview the refreshed contents.

10. Click Submit.

The dataset gets created from a shapefile.
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Create a Dataset Using a File URL
You can create a dataset by specifying the file URL of an external server which hosts the
geospatial file.

Perform the following steps to create a dataset using an external file URL:

1. Navigate to the Datasets page.

2. Click Create Dataset.

The Create Dataset window opens.

3. Select the File URL option.

4. Specify the File URL to access the geospatial data from an external domain.

The following file types are supported:

• Excel spreadsheet

• CSV file

• KML file

• Shape files contained in one zip file

5. Click Create.

The Create Dataset window opens displaying the data columns.

6. Select a value in Upload to connection drop-down.

7. Optionally, review and edit any other parameters as required.

8. Click Submit.

The new dataset gets added and listed on the Datasets page.

Create a Dataset by Loading Raster Images into Oracle Spatial GeoRaster
You can upload raster data files, such as remote sensing images and digital elevation models,
into Oracle Spatial GeoRaster on Autonomous AI Database. Optionally, you can create a
GeoRaster dataset using this uploaded data.

See Spatial GeoRaster Developer's Guide for more information on Oracle GeoRaster feature.

Spatial Studio provides a wizard based on an Extract, Transform, and Load (ETL) process for
creating Oracle GeoRaster objects from geospatial imageries.

Prerequisites for Uploading Raster File
Learn the prerequisite tasks required for uploading raster data in your Autonomous AI
Database.

1. Obtain the georeference information of the raster data to be uploaded.

A raster data file's georeference information may fall into one of the following scenarios:

• The georeference information is self-contained in the raster data file itself, and its
spatial reference system (or SRID) is recognized and supported by Oracle database.

• The raster data file has a companion world-file containing the required parameters,
and SRID is known. You can then provide this SRID and the world-file's content.
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• The raster image is georectified, and the SRID and bounding box values are known.
You can then provide the SRID, and the data file's upper-right and lower-left corners'
coordinates.

2. Copy the raster files to Oracle Cloud Infrastructure Object Storage.

See Putting Data into Object Storage in Oracle Cloud Infrastructure documentation for
more information.

3. Obtain the pre-authenticated request (PAR) URL for the bucket or to a specific file in the
bucket.

See Creating a Pre-Authenticated Request in Object Storage in Oracle Cloud
Infrastructure documentation for more information.

4. Create a compute environment in Spatial Studio. See Create a Compute Environment for
more information.

Use the GeoRaster Dataset Creation Wizard
You can upload raster images into Oracle Spatial GeoRaster database using the GeoRaster
dataset creation wizard.

Before uploading a raster file, ensure you meet the prerequisites described in Prerequisites for
Uploading Raster File.

Perform the following steps to access and use the GeoRaster dataset creation wizard:

1. Navigate to the Datasets page.

2. Click Create Dataset.

The Create Dataset window opens.

3. Select the Imagery file via PAR URL option.

 

 

4. Enter the PAR URL for a file or for a bucket in your Object store.

5. Enter the Relative file path in bucket.

Note that this step is not required if you entered the file URL in the preceding step.

6. Click Create.

The GeoRaster dataset creation workflow opens and the Raster file info step is
displayed as shown:
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Spatial Studio runs the gdalinfo command (from GDAL package) at the backend and the
command output is displayed in Output from gdalinfo command line. The command
retrieves the basic metadata about the raster data file. You can check and view the
imagery information at this step. This includes details such as the imagery dimensions,
number of bands, image pixel storage structure, georeference information if applicable,
and so on.

If errors are reported in Output from gdalinfo command line, then you need to exit the
current uploading process and first resolve the reported issues. Issues are commonly
related to improper configuration of GDAL SDK and Oracle Instant Client packages due to
which Spatial Studio cannot find them from the expected file system folders.

7. Click Next only if no errors are reported in the gdalinfo command output.

The Dataset creation parameters step is displayed as shown:
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8. Optionally, switch ON the Create GeoRaster dataset toggle.

When this option is switched OFF, only the raster file will be uploaded to the database, and
the GeoRaster dataset will not be created in Spatial Studio. You can then later create the
GeoRaster dataset from the database as more options are available for a database-based
GeoRaster dataset. See Create a GeoRaster Dataset for more information.

9. Enter the Raster dataset name and Dataset description.

10. Click Next.

The GeoRaster parameters step is displayed as shown:
 

 

11. Select a connection object using the Upload GeoRaster to connection drop-down to
store the raster data.

12. Choose to upload the raster file to a new GeoRaster table or append the file to an existing
GeoRaster table.

• Upload the raster file to a new GeoRaster table
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a. Select Create new GeoRaster table.
The GeoRaster table has the following hard-coded values:

i. GEOR_OBJ: The GeoRaster column name of type SDO_GEORASTER.

ii. <SRID>: The SRID for the GeoRaster column's geometry metadata.

iii. DESCRIPTION: The Description column name of type VARCHAR2.

iv. IMAGE_KEY: The Key column name of type NUMBER.

• Append the raster file to an existing GeoRaster table

a. Select Choose existing GeoRaster table.

b. Select the values for the following drop-down lists:

– Choose a GeoRaster table name

– Choose a GeoRaster column name

– Choose the key column name

– Choose the description column name

13. Enter Key value and Description text for the GeoRaster table.

14. Choose Create a new RDT table or Choose existing RDT table as it applies.

15. Enter New raster data table name or Choose an RDT table name depending on your
choice in the previous step.

16. Click Next.

The GeoReference parameters step is displayed.
The uploaded raster must have known georeference information in order to be stored in
Oracle database and then be displayed in Spatial Studio.

17. Select a value from the Select a geo-reference option drop-down.

The options for this drop-down can vary depending on the spatial reference system (SRS)
detected by Spatial Studio in the metadata of the raster file. The supported scenarios are:

• Scenario 1: Self-contained Georeference information in the Raster Image File
If the raster image has self-contained georeference information (such as a geo-tiff
image that contains the georeference details), then the Use from raster file option is
automatically applied.

You may directly accept and utilize this self-contained georeference information, and
no other user inputs are needed as shown.

 

Chapter 4
Create a Dataset on Datasets Page

Using Oracle Spatial Studio on Autonomous AI Database
G40399-01
Copyright © 2021, 2026, Oracle and/or its affiliates.

April 10, 2026
Page 14 of 44



 

It is also possible that a valid self-contained georeference information in the raster
image happens to be a user-defined coordinate reference system and therefore not
supported by Oracle Spatial. In such a case, the GDAL package may import the image
into Oracle database but will assign it with an unsupported SRID (for example, a value
of 999999 or 0). Although gdal_translate can upload it into Oracle database, Spatial
Studio will not be able to generate the required metadata due to the absence of the
required georeference information. As a result, this upload process will eventually fail
for such a kind of data file.

If you observe such an error (in the server logs) while uploading, then you must
perform the following steps:

a. Get a valid spatial reference identifier (SRID) that corresponds to the spatial
reference system found in the imagery data.
For this, you can raise a service request with My Oracle Support or refer to Oracle
Spatial Developer's Guide for the steps to create a custom SRID.

b. Repeat all the previous steps (step 1 to step 16) to upload the raster image.

c. Enable the Override spatial reference system switch in the preceding figure for
the GeoReference parameters step.
The raster data file is then treated as not containing georeference information and
thus requires you to provide the details.

d. Follow the steps for Scenario 2 or Scenario 3 as it applies to you.

• Scenario 2: Georeference information Provided in a World-File
If the raster image has a companion world-file (for example, raster file sf1.jps has a
companion sf1.wld file), and both are stored in the same folder, then select the Enter
World-File content georeference option as shown.
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a. Enter raster image SRID: Enter the SRID for the spatial reference system.

b. Enter the world-file content here: Enter the world file's contents. Note that each
parameter takes one line and six parameters occupy six consecutive lines.

• Scenario 3: Georectified Raster Image with Known Bounding Box Values
If the raster image is already georectified and you know its SRID and bounding box
values, then select the Enter Imagery bounding box coordinates for a Valid SRID
georeference option as shown.
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a. Enter raster image SRID: Enter the SRID for the spatial reference system.

b. Upper-right corner's X, Upper-right corner's Y: Enter the upper-right corner's
coordinates.

c. Lower-left corner's X, Lower-left corner's Y: Enter the lower-left corner's
coordinates.

18. Click Next to provide additional GeoRaster parameters.

The Additional parameters step is displayed as shown:
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19. Optionally, modify the default parameters (if required) to fine tune the GeoRaster storage
related parameters.

If you are aware that there is a special value for raster cells indicating NODATA, then turn
on the Provide a value for NODATA switch and provide its value.

20. Click Next to confirm the inputs.

You may scroll down the text area and view all the parameters entered or selected in the
previous steps. You may choose to go to any earlier steps to modify inputs.

21. Click OK.

The server will initiate a backend process to upload the raster data files into the database,
and then optionally create a dataset in Spatial Studio. The application displays a task
completion notification and you can also verify the same in the Jobs page.

Create a GeoRaster Dataset
Spatial Studio allows you to create Georaster datasets.

You can create a GeoRaster dataset using the following steps.

The instructions assume that the GeoRaster data is already existing on your Autonomous AI
Database instance.

1. Navigate to the Datasets page and click Create Dataset.

2. Click Database table/view, select the default Connection and click Create.

3. Expand the connection folder and click open GeoRasters.

4. Select the required GeoRaster table and click OK.

The Geo-raster Configuration dialog opens.

5. Choose a Selection Mode.

The values for the selection mode are:

• Single Raster

• Virtual Mosaic

6. Select the GeoRaster column for visualization if you have chosen the Single Raster mode.
Otherwise, you can skip this step.

Note

If you have chosen the Virtual Mosaic mode, all the Georaster columns are
included in the visualization.

7. Optionally, enable Wind Animation if the raster image is encoded with velocities in the red
(x-axis) and green (y-axis) channels, and you wish to visualize wind animation.

See About Wind Animation for more information.

8. Provide the following Data Range values: Min velocity in x axis, Max velocity in x axis,
Min velocity in y axis, and Max velocity in y axis only if you enabled Wind Animation in
the preceding step.

9. Click OK.

The GeoRaster dataset is configured and the newly created GeoRaster dataset is
displayed as a row in the Datasets page.
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Create a Wind Animation Dataset
You can create a wind animation dataset which can be used for visualizing wind speeds and
dynamic flow on a map.

As a prerequisite for creating a wind animation dataset, ensure that:

• The base wind image is generated. See Generate a Base Wind Image From a NOAA
Dataset for an example.

• The generated base wind image is loaded as a GeoRaster to Oracle Database. See Use
the GeoRaster Dataset Creation Wizard for more information.

Perform the following steps to create a wind animation dataset:

1. Navigate to the Datasets page.

2. Click Create Dataset.

The Create Dataset window opens.

3. Click Database table/view, select a Connection and click Create.

4. Click GeoRasters, select the GeoRaster table containing the base image, and click OK.

The Geo-raster Configuration dialog opens as shown:
 

 

5. Set the Selection Mode to Single Raster.

6. Switch ON the Wind Animation toggle.
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7. Enter the following Data Range values: Min velocity in x axis, Max velocity in x axis,
Min velocity in y axis and Max velocity in y axis.

Note the following:

• These values are obtained at the time of generating the base wind image. See 
Generate a Base Wind Image From a NOAA Dataset for an example.

• These values need to be set only the first time you create a wind animation dataset
from this GeoRaster table. Once saved, these parameters will be stored in the
GeoRaster table. Hence, the future datasets will not require manual input of the Data
Range values, unless you choose to update them.

8. Click OK.

The wind animation dataset gets created and is displayed on the Datasets page.

Related Topics

• About Wind Animation
You can create and visualize wind animations that depict the direction of flow between
various locations.

Generate a Spatial Analysis Dataset
Spatial Studio stores the results of a spatial analysis operation in a spatial analysis dataset.
Also, storing selected geographic features or pins on a map layer gets saved as a new spatial
analysis dataset.

When you perform any new spatial analysis operation (such as filtering, combining,
transforming existing datasets, and so on) against a data source in map visualization, the
results of the analysis are generated into a spatial analysis dataset. Similarly, when you store
selected geographic locations or pins on a map layer, the spatial data gets stored as spatial
analysis datasets. These datasets get instantly added to the map visualization project and
appear under Analysis in the Active Project page. You can also view these datasets on the
Datasets page.

Save Selected Features on a Map Into a Dataset
You can save selected features on a map layer into a new spatial analysis dataset.

The following steps enable you to save selected features on a map layer into a dataset.

The instructions assume that you have a project opened on your Active Project page.

1. Select the required features to be saved to the dataset.

If you are using a Windows system, you can select multiple features using the keyboard
shortcut Ctrl+Click.

2. Click the Actions icon on the map tool bar.

3. Select Save Selections from the drop-down menu.
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The Save selections dialog opens.

4. Enter the Analysis name.

5. Select the required columns from the Save Selections From drop-down list.

6. Click Run.

The new (analysis) dataset containing the saved selections is created and gets listed
under Analyses on the left pane in the Active Project page. It also appears on the table in
the Datasets page.

7. Verify the selection, by dragging and dropping the analysis dataset on the map view.

You can now view only selected features on the map layer:
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Save Pins on a Map Into a Dataset
You can save all the pins that you dropped on a map layer into a spatial analysis dataset.

This dataset containing the stored pins can later be used in various spatial analyses.

The following steps enable you to save multiple pins on a map layer into a dataset.

The instructions assume that you have a project opened on your Active Project page and the
map layer displayed for visualization contains multiple pins.

1. Click the Actions icon on the map tool bar.

2. Select Save Pins from the drop-down menu.

The Save pinned places dialog opens.

3. Enter the Analysis name.

4. Select the required Connection for saving the dataset.

5. Click Run.

The new dataset containing the pins is created and gets listed under Analyses on the left
pane in the Active Project page. It also appears on the table in the Datasets page.

6. Verify the saved pins, by dragging and dropping the analysis dataset on the map view.

The saved pins are displayed as points and not as a pin location on the map layer. This is
because the pins get saved to a regular point type dataset. You can now perform various
spatial analyses on the map using this dataset layer.

Manage Datasets
You can explore and manage the datasets on the Datasets page.

Topics:

• Export a Dataset to GeoJSON

• Geocode a Dataset

• Reverse Geocode a Dataset

• Prepare an H3 Aggregation Dataset
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• Enable Spatiotemporal for a Dataset

• Enable Wind Animation For an Existing GeoRaster Dataset

• Prepare a Non-Spatial Dataset for Analysis

• Update Statistics for Datasets

• About Cache in Spatial Studio

Export a Dataset to GeoJSON
You can export a dataset from Spatial Studio to GeoJSON.

It is possible that your dataset can contain multiple geometry columns. In such a case, Spatial
Studio allows you to select a specific geometry column for the export operation.

The instructions assume that a dataset containing the coordinates details is already existing in
your database schema.

1. Navigate to the Datasets page.

2. Right-click on the dataset name which you want to export.

3. Select Export.

The dataset Export dialog opens as shown:
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4. Select GeoJSON from the File Format drop-down list.

5. Optionally, increase or decrease the Decimal places in coordinates as required.

6. Select a geometry column as required.

7. Select the required columns for the export.

8. Click OK.

9. Save the .zip file containing the GeoJSON data on your system.

Geocode a Dataset
Geocoding is the process of deriving the latitude and longitude coordinates from location
details that are geo address types.

You can geocode a dataset in Spatial Studio to store the resulting latitude and longitude
information as a SDO_GEOMETRY column. Optionally, you can also store them in latitude and
longitude numeric columns in the underlying database table referenced by the dataset.
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Prior to geocoding a dataset, if the Spatial Studio server is running behind a firewall, then
ensure you have the correct Web Proxy information configured in the Console page. This is
because the Spatial Studio application uses an external Oracle hosted geocoding service
which is on the public internet.

Note

Compute environment is required if you are geocoding a dataset with more than 500
records. See Create a Compute Environment for more information.

You can perform the following steps to geocode a dataset.

The instructions assume that a dataset containing location columns such as address details is
already existing in Spatial Studio.

1. Navigate to the Datasets page.

2. Right-click on the dataset name on which you want to apply geocoding.

Ensure that the dataset has a valid key column defined.

3. Select Geocode Addresses from the Prepare context menu.

Geocode Addresses dialog opens as shown:

4. Click the Setup tab.

5. Perform one of the following depending on whether the address attributes are stored in a
single column or multiple columns:

• Single Column Address

a. Switch ON the Single column address toggle.
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b. Verify or select the required address Column.

• Address Stored in Multiple Columns

a. Select the Address Components for the geo-attributes to be used for geocoding.
You must provide sufficient geographic data for successful geocoding. If the
address components do not include the country or state attributes, then you must
explicitly select either the country or the state in the respective drop-down list
shown highlighted in the preceding figure.

6. Optionally, switch ON Save coordinates in columns to save the geocoordinates to the
dataset and to the underlying database table.

7. Optionally, enter Latitude column name and Longitude column name, if you switched
ON Save coordinates in columns in the preceding step.

8. Click Apply.

The geocoding process gets initiated and can be monitored on the Jobs page. Also, note
the following:

• The geocoding process is performed in batches and the default batch size is 50. At any
time, you can change the default geocoding batch size under the General settings in
the Console page.

• If any batch fails, the overall geocoding job will not fail. You will be notified on the failed
batch at the end of job completion.

• At the end of the geocoding process, you can view the results in the Status tab as
shown:
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• On successful completion of a geocoding job, you can verify that geocoding has been
applied by viewing the latitude and longitude columns in the dataset properties and in
the input source database table along with the GC_GEOMETRY column of data type
SDO_GEOMETRY.

Reverse Geocode a Dataset
Reverse geocoding is the process of deriving the address information from a set of latitude and
longitude coordinates.

You can reverse geocode a dataset in Spatial Studio to add address information to the
dataset's table using the following steps.

Note

Reverse Geocoding is supported only in point or latitude and longitude datasets.

The instructions assume that a dataset containing the coordinates details is already existing in
your database schema.

1. Navigate to the Datasets page.
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2. Right-click on the dataset name on which you want to apply reverse geocoding.

3. Select Reverse Geocode from the Prepare context menu.

4. Optionally, select and modify the required Location attributes.

The Input text fields for Location attributes are the column names to be created in the
underlying database table for the target dataset.

5. Select the Advanced option as required.

The default Reverse geocode to named roads only option ensures that for all latitude
and longitude coordinates that do not match a named road, the closest street or road name
will be obtained while geocoding.

6. Click Apply.

You can monitor the Reverse geocode dataset background task on the Jobs page. A
successful completion of the job indicates that reverse geocoding is applied for the data in
the dataset.

You can verify that reverse geocoding has been applied to your dataset by viewing the
additional address related columns in the dataset properties.
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Prepare an H3 Aggregation Dataset
You can prepare an H3 aggregation dataset by performing the following steps.
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The instructions assume that a dataset containing geometric data columns is already loaded to
Spatial Studio.

1. Navigate to the Datasets page.

All the datasets loaded to Spatial Studio are shown listed on this page.

2. Select the required dataset name and right-click to open the context menu.

3. Click Create H3 Index on the Prepare submenu.

The Creating H3 Index dialog opens as shown:

4. Select the Geometry Column for H3 aggregations.

5. Click a Summarize using option.

The values for summarizing are:

• Count: buckets the number of datapoints in each hexagon

• Sum: adds up the values for a specific column in the data set, for all the points that fall
in a specific hexagon

6. Select the Column to sum, if you have chosen Sum to summarize your dataset.
Otherwise, you can skip this step.

7. Optionally, modify the H3 Index Name.

8. Click OK.

An H3 aggregation dataset is created and added as a new row in the Datasets page.

Enable Spatiotemporal for a Dataset
In order to visualize and animate spatiotemporal data, you must enable Spatiotemporal for
the dataset on the Datasets page.

Spatial Studio supports visualization and animation of spatiotemporal map layers using a
Cesium Timeline widget (see Overview of the Cesium Timeline Widget). These map layers can
listen to the timeline only if you enable Spatiotemporal on the underlying datasets.
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Characteristics of a Spatiotemporal Dataset

Spatial Studio considers a dataset to contain spatiotemporal data if it belongs to any one of the
following types.

• Live Spatiotemporal Dataset: A dataset which meets the following characteristics is
known as a Live dataset:

– The dataset is based on a geometry table or view with a geometry column or pair of
latitude/longitude columns.

– The dataset has one or more entities (that represent an object in the dataset) which
are uniquely identified by one of the columns.

– The dataset's underlying table or view contains a column of the type TIMESTAMP or
DATE (or a qualifying field in the GeoJSON response), that stores the UTC datetime of
the entities as they are being observed and recorded.

– The dataset's underlying table or view must have ongoing inserts with recently
obtained location data of entities being observed or monitored.

Spatial Studio considers all the different dataset rows of the same entity id as entries
representing the entity with different TIMESTAMP values. However, they may or may not
have varying location coordinates or geometries. Hence, these live spatiotemporal
datasets can again be classified as shown:

– Moving Objects: For each entity, if the location or geometry change with changing
TIMESTAMP values, then these datasets are called moving objects datasets. In this
case, a trail layer (if it is a qualifying geometry) gets added, which shows the trajectory
of the moving object as a line string by fetching data for last N seconds (or higher time
unit).

– Non-Moving Objects: For each entity, if only certain properties change (and not the
location or geometry) with changing TIMESTAMP, then these are called non-moving
objects datasets. In this case, no trail layer gets added as only the properties change
with time.

• Non-Live Spatiotemporal Dataset: A dataset with the following characteristics is known
as a Non-Live dataset:

– The dataset is based on a geometry table or view with a geometry column or pair of
latitude/longitude columns.

– The dataset's underlying table or view contains a TIMESTAMP or DATE type column that
contains historic time values.

These datasets can again be classified as shown:

– Moving Objects: Similar to a Live dataset, if this dataset contains entities (that
uniquely represent an object in the dataset) with varying TIMESTAMP values, then a trail
layer gets added. The trail layer shows the trajectory of the moving object as a line
string by fetching data for last N seconds (or higher time unit).

– Non-Moving Objects: In this configuration, the dataset is just treated to have various
rows with different TIMESTAMP values (not grouped by any entity id).

• Time-enabled WMS Dataset: If a WMS Service offers a time dimension for an image layer
selected in a WMS dataset, then that WMS Dataset can be configured as spatiotemporal.

• GeoJSON URL (external) Dataset: These types of datasets can be configured to refresh
periodically based on an interval value.
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Configure Spatiotemporal for Live Moving Objects Dataset
Perform the following steps to configure spatiotemporal for a live dataset with moving objects.
The instructions assume that such a dataset is already existing in your database schema.

1. Navigate to the Datasets page.

2. Right-click on the required spatiotemporal dataset and click Properties.

The Dataset Properties dialog opens.

3. Click the Spatiotemporal tab.

The following dialog is displayed:

4. Switch ON Enable Spatiotemporal.

5. Select the Timestamp (or Date) Column.

• Both date-type and timestamp-type columns are supported.

• If using a timestamp-type column, then note that Spatial Studio supports only UTC
(Coordinated Universal Time) or GMT (Greenwich Mean Time) time zone for
visualizing moving objects.

6. Switch ON Data is live.

7. Switch ON Moving objects.

8. Select the Entity ID Column that identifies a set of unique entities.

The Entity ID Column is not a unique column as each entity can have many recordings of
its locations in the same table.

9. Specify Data Change Rate to indicate the approximate frequency of the live feed updates
in the table.

10. Optionally, select the Altitude Column for Cesium Map Visualization only.

11. Click Apply.

Your dataset is now enabled for spatiotemporal data visualization.
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Related Topics

• Visualize Live Moving Objects Dataset
You can visualize live moving objects on a map in Spatial Studio.

Configure Spatiotemporal for Live and Non-Moving Objects Dataset
Perform the following steps to configure spatiotemporal for a dataset containing live real-time
data on non-moving objects. Although the data attributes of the different entities can vary with
time, the entity locations do not change. The instructions assume that such a dataset is already
existing in your database schema.

1. Navigate to the Datasets page.

2. Right-click on the required spatiotemporal dataset and click Properties.

The Dataset Properties dialog opens.

3. Click the Spatiotemporal tab.

4. Switch ON Enable Spatiotemporal.

5. Select the Timestamp (or Date) Column.

• Both date-type and timestamp-type columns are supported.

• If using a timestamp-type column, then note that Spatial Studio supports only UTC
(Coordinated Universal Time) or GMT (Greenwich Mean Time) time zone for
visualizing moving objects.

6. Switch ON Data is live.

7. Switch OFF Moving objects.

8. Select the Entity ID Column that identifies a set of unique entities.

The Entity ID Column is not a unique column as each entity can have many recordings of
its locations in the same table.

9. Specify Data Change Rate to indicate the approximate frequency of the live feed updates
in the table.

10. Optionally, select the Altitude Column for Cesium Map Visualization only.

11. Click Apply.

Your dataset is now enabled for spatiotemporal data visualization.

Related Topics

• Visualize Live and Non-Moving Objects Dataset
You can visualize a spatiotemporal dataset having ongoing inserts of real-time data, but
the locations of the data entities do not change.

Configure Spatiotemporal for Non-Live Moving Objects Dataset
Perform the following steps to configure spatiotemporal for a dataset containing non-live data
on moving objects. The instructions assume that such a dataset is already existing in your
database schema.

1. Navigate to the Datasets page.

2. Right-click on the required spatiotemporal dataset and click Properties.

The Dataset Properties dialog opens.

3. Click the Spatiotemporal tab.
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The following dialog is displayed:

4. Switch ON Enable Spatiotemporal.

5. Select the Timestamp (or Date) Column.

• Both date-type and timestamp-type columns are supported.

• If using a timestamp-type column, then note that Spatial Studio supports only UTC
(Coordinated Universal Time) or GMT (Greenwich Mean Time) time zone for
visualizing moving objects.

6. Switch OFF Data is live.

7. Switch ON Moving objects.

8. Select the Entity ID Column that identifies a set of unique entities.

The Entity ID Column is not a unique column as each entity can have many recordings of
its locations in the same table.

9. Select the Time Unit.

10. Click Apply.

Your dataset is now enabled for spatiotemporal data visualization.

Related Topics

• Visualize Non-Live Moving Objects Dataset
You can visualize moving objects with historic timestamp values on a map in Spatial
Studio.

Configure Spatiotemporal for Non-Live and Non-Moving Objects Dataset
Perform the following steps to configure spatiotemporal for a dataset containing non-moving
objects with different timestamp values. The instructions assume that such a dataset is already
existing in your database schema.

1. Navigate to the Datasets page.

2. Right-click on the required spatiotemporal dataset and click Properties.

The Dataset Properties dialog opens.

3. Click the Spatiotemporal tab.
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The following dialog is displayed:

4. Switch ON Enable Spatiotemporal.

5. Select the Timestamp (or Date) Column.

• Both date-type and timestamp-type columns are supported.

• If using a timestamp-type column, then note that Spatial Studio supports only UTC
(Coordinated Universal Time) or GMT (Greenwich Mean Time) time zone for
visualizing moving objects.

6. Switch OFF Data is live.

7. Switch OFF Moving objects.

8. Select the Time Unit.

The data will be filtered as per the selected time unit.
Also, note that the filtering is applied at the dataset level. This implies that all the layers
created out of this dataset will have the same filtering when added to the timeline.

9. Click Apply.

Your dataset is now enabled for spatiotemporal data visualization.

Related Topics

• Visualize Non-Live and Non-Moving Objects Dataset
You can visualize a spatiotemporal dataset that simply contains different timestamp values
in each row which are not grouped by any entity ids.

Configure Spatiotemporal for OGC WMS Datasets
Perform the following steps to configure spatiotemporal for an OGC WMS dataset.
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1. Navigate to the Datasets page.

2. Right-click on the required OGC WMS dataset and click Properties.

The Dataset Properties dialog opens.

3. Click the Spatiotemporal tab.

The following dialog is displayed:

4. Switch ON Enable Spatiotemporal.

5. Click Apply.

Your dataset is now enabled for spatiotemporal data visualization.

Related Topics

• Visualize OGC WMS Maps as a Dataset
You can visualize an OGC (Open Geospatial Consortium) WMS (Web Map Service)
dataset on a map.

Configure Spatiotemporal for GeoJSON URL Datasets
Perform the following steps to configure spatiotemporal for a GeoJSON URL based dataset.

1. Navigate to the Datasets page.

2. Right-click on the required GeoJSON URL dataset and click Properties.

The Dataset Properties dialog opens.

3. Click the Spatiotemporal tab.

4. Switch ON Enable Spatiotemporal.

5. Click Apply.

Your dataset is now enabled for spatiotemporal data visualization. Also, note that the dataset
will be considered Live by default.

Related Topics

• Visualize GeoJSON URL Datasets with Spatiotemporal Data
You can visualize GeoJSON URL based datasets that contain spatiotemporal data.
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Enable Wind Animation For an Existing GeoRaster Dataset
You can enable wind animation for an existing GeoRaster dataset only if the raster image is
encoded with the red (R) and green (G) channels representing the x and y velocities,
respectively.

1. Navigate to the Datasets page.

2. Right-click on the required GeoRaster dataset and click Properties.

The Dataset Properties dialog opens as shown.
 

 

3. Click the GeoRaster tab.

4. Switch ON the Wind Animation toggle.

5. Optionally, modify the following Data Range values: Min velocity in x axis, Max velocity
in x axis, Min velocity in y axis, and Max velocity in y axis.

6. Click Apply.

Prepare a Non-Spatial Dataset for Analysis
Spatial Studio allows you to prepare a non-spatial dataset for mapping and analysis by joining
to a spatial dataset.

Note the following highlights about joining two datasets:

• You can only join a non-spatial dataset to a spatial dataset and not conversely.

• It is essential that the non-spatial data in one dataset is linked to the spatial data in the
other dataset through a common primary key column.
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• You can choose the columns for the newly created joined dataset from the attributes of the
datasets associated in the join operation.

The instructions assume that a spatial dataset and a non-spatial dataset having a common
primary key data is already existing in your database schema.

1. Navigate to the Datasets page.

2. Right-click on the non-spatial dataset which you want to join to a spatial dataset.

3. Select Join to Spatial Dataset from the Prepare context menu.

The following window opens:

4. Optionally, enter a dataset name for Name of join result dataset.

5. Select the Spatial dataset for the join.

On selection, the primary key associated with the spatial dataset is validated against the
non-spatial dataset key. If the datasets key values are not suitable for a join operation, then
the following error is displayed:

Dataset key columns to join must be the same data type

6. Optionally, select the required columns for the joined result dataset from the non-spatial
and spatial datasets.

7. Click OK.

The joined dataset is created and it appears as a row on the Datasets Page. This dataset
will contain all the column properties selected from both the spatial and non-spatial
datasets. You can verify the properties of the joined dataset both in the Dataset
Properties window on the Datasets page and when using the dataset for map visualization
and analysis on the Active Projects page, as shown:
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Update Statistics for Datasets
The Update statistics feature in Spatial Studio gathers statistics of the dataset columns.

To gather the dataset statistics, right-click on the dataset and select Update statistics. For all
datasets (except view-based and spatial analysis datasets), this action triggers a single
background job which collects the relevant statistical data. Once the job completes
successfully on the Jobs page, you can verify the updated statistical data by viewing the
Dataset Properties.

However, for view-based and spatial analysis datasets, gathering statistics is a two-step
process. It implies that two background jobs are triggered:

1. Gather dataset statistics [basic]: This job collects the basic statistics such as Name and
DataType of columns in a dataset. When this job completes successfully, the job in step-2
is triggered.

2. Gather dataset statistics [full]: This job collects more detailed statistics such as
Minimum Value, Maximum Value, Bounding Box, and unique column values. As long as
this job is in the Processing status, the view-based dataset may show incomplete
information for the Minimum Value and Maximum Value columns in the Dataset
Properties dialog:
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Once the job status is Done, the Dataset Properties reflects the gathered statistics.

Note that for any type of dataset, you must always ensure that this background job completes
successfully before performing advanced styling or visualization of a dataset.
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About Cache in Spatial Studio
All vector tiles generated for all datasets are cached to the file system by default.

This cache process automatically begins when the you first load a dataset for map visualization
and start panning the map or zoom in and out on the map. Therefore, the next time the same
dataset is visualized, all the corresponding map layers load faster as the relevant tiles have
been already generated and are ready to be loaded. All these generated vector tiles will be
saved under:

<user_home_folder>/.sgtech/cache/CACHE_<cache_id>

The <cache_id> which is part of the folder name is an integer value, calculated based on the
dataset id and the geometry column being encoded in the vector tiles. A metadata file will be
saved inside each cache folder to provide human-readable information about where the tiles
belong to in a tiles.json file. A sample structure of the metadata file is as shown:

{
  "DatasetName" : "DATASET NAME",
  "DatasetId" : "8da55629d3ca71aa37d859422a847257",
  "GeometryColumn" : "GEOM_COL_NAME"
}

Each vector tile will be encoded and saved to a file that follows a name pattern as shown:

<zoom_level>_<x_axis>_<y_axis>.dat

All the variables in the preceding name pattern are replaced by an integer and denote the
world position where the tile needs to be loaded when looking at a certain viewport of the world
map.

The cache options (Pre-cache and Purge cache) for a dataset can be accessed from the
Datasets page as shown:
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Pre-Cache
You can trigger a pre-caching task to start generating vector tiles even before a map is loaded
with the dataset for visualization.

You can access the Pre-cache option as shown in this Figure.

Pre-caching can infer where the data is located and suggest the data bounds for caching. In
case if the information is not available, then you can interactively select the part of the world
that needs to be included in the pre-caching task. Spatial Studio also suggests the zoom levels
that are best suited for the data. However, you can always override this and configure your
own choice for the Zoom levels.
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Note

Based on the complexity of the data and the number of zoom levels to pre-cache, this
task could take from a couple of minutes to several hours. Therefore, be cautious on
what you opt to include in this process as the database connections and CPU usage
could heavily be impacted by this task.
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The pre-cached tiles are saved in the file system, following the name pattern discussed in the
earlier section. Extra information about the bounding rectangle and zoom levels that were pre-
cached are included in the tiles.json file as shown:

{
  "DatasetName" : "DATASET NAME",
  "DatasetId" : "8da55629d3ca71aa37d859422a847257",
  "GeometryColumn" : "GEOM_COL_NAME",
  "ZoomLevels" : [ 13, 14, 15 ],
  "BoundingBox" : [ -103.455841, 20.708551, -103.421479, 20.73044 ]
}

Purge Cache
You can wipe the cached tiles by calling the Purge cache option.

You can access the Purge cache option as shown in this Figure.

This option is helpful whenever the database data changes causing the already generated
vector tiles to become stale.

Alternatively, you can also select the Refresh layer option for each dataset layer that is added
to the map visualization in the Active Project page as shown:

This indirectly triggers a Purge cache operation, before generating the vector tiles again.

You must perform a cache purge or layer refresh whenever you apply any of the following
changes to a dataset:

• Change the key column of a dataset

• Enable or disable columns of a dataset

• Change the contents of your dataset's source table

Otherwise, you will be viewing stale data on the map and interacting with this data may also
result in errors.
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5
Work with Connections

Spatial Studio gains access to the data on your Autonomous AI Database Serverless instance
through the MY_DEFAULT_CONNECTION object.

You can also create a single custom connection to another Autonomous AI Database instance
with or without a wallet. In addition, creating an external connection to an OGC WMS service is
also supported.

Topics:

• Overview of Connections Page

• Create an OGC WMS Connection

• Create a Connection to an Autonomous AI Database Instance

Overview of Connections Page
The Connections page displays all the existing connections and also allows you to create a
new OGC (Open Geospatial Consortium) WMS (Web Map Service) connection.

The following figure shows the Connections page:

 

 
Spatial Studio automatically creates a default connection object (MY_DEFAULT_CONNECTION)
through which you can access data on your Autonomous AI Database Serverless instance.

You can also create a new connection to an OGC WMS service.

When a new data source connection is created, GeoRaster will be automatically enabled if it
was not already enabled in the database schema. You can also perform the following actions
by clicking the hamburger icon against any displayed connection or by right-clicking a
connection row:

• Properties: To view the properties of the connection in the Overview tab.
You can control the generation of vector tiles and H3 hexagons with the Use on-DB
Vector Tile Generation and Use on-DB H3 Generation toggles in the Settings tab.

Spatial Studio by default relies on the Autonomous AI Database server's built-in
capabilities to generate the vector tiles and H3 hexagons. Therefore, you must typically
keep these toggles ON. In rare situations, you may want to switch OFF these toggles in
order to debug potential bugs introduced by a new Autonomous AI Database patch. When
set to OFF, Spatial Studio generates vector tiles and H3 hexagons in the mid-tier instead of
within the database server.
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• Edit: To update the connection details.

Note

You cannot edit the MY_DEFAULT_CONNECTION object on the Connections page.

• Test Connection: To validate the connection.

• Delete: To delete the connection along with all its datasets.

Note

You cannot delete the MY_DEFAULT_CONNECTION object.

Create an OGC WMS Connection
You can create a new connection to an external OGC (Open Geospatial Consortium) WMS
(Web Map Service) service.

This enables you to create an OGC WMS dataset which can be used in map visualizations.
Note that a WMS service or server typically offers many individual map layers that can be
combined in different orders. The full list of available map layers, as well as many other
important supported functionalities are all advertised by the WMS server through a standard
WMS GetCapabilities response.

When you create a new WMS connection, Spatial Studio will be querying such capabilities
against the external WMS server using the standard GetCapabilities call. Based on the result
of such a query, you will later be able to choose the required WMS map layers that must be
included when creating a new Spatial Studio WMS dataset.

You can perform the following steps to create an OGC WMS connection:

1. Navigate to the Connections page.

2. Click Create Connection.

The Create Connection dialog opens.

3. Select OGC Web Map Service as the connection type and click Next.

The Create Connection dialog open as shown:
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4. Enter the connection Name.

5. Optionally, enter a Description.

6. Enter the WMS URL to connect to the WMS service.

Also, note the following:

• Ensure that the WMS URL is added to the Safe Domains list.

• You can use one of the following two formats for the WMS URL:

– A complete GetCapabilities request, including the version of the WMS
specification (1.3.0 is recommended). For instance:
https://nowcoast.noaa.gov/geoserver/observations/weather_radar/ows?
SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

– The base URL of the WMS server. For instance:
https://nowcoast.noaa.gov/geoserver/observations/weather_radar/ows

7. Optionally, select the WMS VERSION.

8. Click OK.

The OGC WMS connection gets created. This wms type connection is displayed on the
Connections page.
Also, the new WMS connection stores the names of all the available map layers (hosted by
the WMS service) and a host of other information based on the GetCapabilities response
as a part of its metadata.
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9. Right-click on the newly created connection, select Test connection, and verify that the
connection tests successfully.

Create a Connection to an Autonomous AI Database Instance
You can create a custom connection to an Autonomous AI Database instance in Spatial Studio.

1. Navigate to the Connections page.

2. Click Create Connection.

The Create Connection dialog opens.

3. Select Oracle Autonomous Database as the connection type and click Next.

The Select ADB authentication type dialog opens.

4. Select an authentication type as desired and click OK.

Depending on your choice, perform one of the following to create a custom connection to
your Autonomous AI Database instance:

Note

You can create only one custom connection to your Autonomous AI Database
instance at a time. If you wish to create another one, then you must delete any
existing custom connection.

• Wallet-based: See Use a Wallet-Based mTLS Connection for more information.

• Wallet-less (TLS): See Use a Walletless TLS Connection for more information.

Use a Wallet-Based mTLS Connection
You can create a Spatial Studio connection to an Autonomous AI Database instance using a
wallet-based mutual Transport Layer Security (mTLS) authentication.

Before you begin, ensure you meet the following prerequisites:

• Download and save the wallet for your Autonomous AI Database instance from the Oracle
Cloud Infrastructure (OCI) console. See Download Client Credentials (Wallets) for more
information.

• The instructions in this section assume that you have already performed the steps
described in Create a Connection to an Autonomous AI Database Instance and you chose
to create a Wallet-based connection.

You can then continue to perform the following steps to set up a cloud connection to your
Autonomous AI Database instance using the downloaded wallet.

1. Drag and drop your saved wallet file or click to upload the wallet from your system in the
Upload wallet dialog.

2. Click OK.

The Create Connection dialog opens as shown:
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3. Optionally, change the default Spatial Studio connection Name.

4. Optionally, enter a Description.

5. Enter the Autonomous AI Database User name and the Password for the user.

6. Select the appropriate Service from the drop-down list.

7. Optionally, enter the Proxy Host and Proxy Port details.

8. Click OK.

The connection to the Autonomous AI Database instance gets created and is displayed on
the Connections page.

Use a Walletless TLS Connection
You can create a Spatial Studio connection to an Autonomous AI Database instance using a
walletless Transport Layer Security (TLS) authentication.

Before you begin, ensure you meet the following prerequisites:

• Obtain the connection string for your Autonomous AI Database instance:

1. Navigate to you Autonomous AI Database details page and locate the Network
section.
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2. Specify an access control rule.

a. Click Edit next to the Access Control List (ACL).

b. Click Add access control and add the IP address of your client machine to
configure an access control rule.

c. Click Save.

3. Disable Mutual TLS (mTLS) Authentication if it is not already disabled.

a. Click Edit next to the Mutual TLS (mTLS) Authentication.

b. Uncheck Require mutual TLS (mTLS) authentication.

c. Click Save.

4. Obtain the database connection string.

a. Click Database Connection on the Autonomous AI Database details page.

b. Select TLS under TLS Authentication to view the list of connection strings.

c. Copy the required Connection String.
The connection string follows a format as shown:

(description=(retry_count=20)(retry_delay=3)(address=(protocol=tcps)
(port=1522)(host=<host_name>.oraclecloud.com))
(connect_data=(service_name=<service_name>.adb.oraclecloud.com))
(security=(ssl_server_dn_match=yes))

• The instructions in this section assume that you have already performed the steps
described in Create a Connection to an Autonomous AI Database Instance and you chose
to create a Wallet-less (TLS) connection.

You can then continue to perform the following steps to set up a cloud connection to your
Autonomous AI Database instance in the Create Connection dialog.
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1. Optionally, change the default Spatial Studio connection Name.

2. Optionally, enter a Description.

3. Enter the Connection string obtained at the beginning of the section.

4. Enter the Autonomous AI Database User name and the Password for the user.

5. Optionally, enter the Proxy Host and Proxy Port details.

6. Click OK.

The connection to the Autonomous AI Database instance gets created and is displayed on
the Connections page.
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6
Work with Jobs

You can view the list of background jobs that run in Spatial Studio on the Jobs page.

Topics:

• Overview Jobs Page

Overview Jobs Page
The Jobs page displays details of all the background jobs that run in Spatial Studio.

The following figure shows a layout of the Jobs page:

You can perform the following actions on the Jobs page:

• Select a job to be displayed in the grid: Active, Past or All.

• View details of a specific job.

• Terminate a job.
Also, note the following about terminating a job:

– You can terminate a Processing or Pending job.

– You can terminate all job types except Create lon-lat index jobs.

– Upon termination of a job, partial execution results of the job are maintained. You can
choose to clear the partial results. For example, you can perform Clear Address
Geocode after terminating a Geocode job.

– Only jobs related to H3 aggregations such as Build H3 Index are completely rolled
back when terminated.

The grid table displays the following properties for each job entry row:

• Type: The job type, such as "Geocode", "Reverse geocode dataset" and so on.

• Object: The entity being altered by the job, which can be a Dataset, Table, Index or other.

• Created by: The user that submitted the job.
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Note

System maintenance jobs are created by “$system” account

• Start Time: The scheduled next run time for jobs with Pending status or the actual job start
time for any other job status.

• End Time: The time at which a job completed.

• Status: Indicates the state or progress of a job, which can be:

– Pending

– Processing

– Done

– Error

– Terminating

– Terminated

By clicking  against any job row, you can perform the following actions :

• View Details: To view extra information, such as the step at which a Processing job is
currently running or error details for Error or Terminated jobs. Also, you can terminate a
Processing job by clicking Terminate when viewing the job details.

• Terminate: To terminate a Processing or Pending job directly. It remains disabled for any
other job status.
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7
Work with Console

If you are a Spatial Studio administrator, you can manage custom basemaps,configure safe
domains, and manage system notifications on the Console page.

Topics

• Overview of Console Page

• Configure Custom Branding

• Configure Zip Upload Settings

• Manage Safe Domains

• Add a Custom Basemap

• Edit a Custom Basemap

• Upload a Map Symbol

• Create a Compute Environment

• Set Cache and Dataset Files Upload Size Limits

• Create and Manage Tokens

• Manage System Notifications

• View and Manage Server Logs

Overview of Console Page
The Console menu link directs you to the Console page. The following shows the Console
page layouts in two scenarios:

Layout of the Console page when Spatial Studio is attached to the compute
environment while logged in as a Spatial Studio ADMIN user
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Layout of the Console page when Spatial Studio is not attached to the compute
environment while logged in as a Spatial Studio ADMIN user

 

 
As seen in the preceding figure, the Console menu options are limited when working in Spatial
Studio without a compute environment.

Note

If you are logged in as an administrator of Spatial Studio, then you can access all the
supported Console menu options. Otherwise, you can access only the Map symbols
and My compute environment options (under Settings), and Access Tokens (under
Security).

The following sections describe the supported Console menu options under different
categories:
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Settings

• General: This slider allows changing the GeoCoding service URL, the geocoding batch
size, and the web proxy used by the Studio server. It also allows you to customize the front
end branding area of the application.

• GDAL Installation Info: This slider allows you to verify the GDAL SDK and Oracle Instant
Client installations and to view the location path on the server for these installations.

• Safe Domains: This slider allows the administrator to manage the white listing of the
domains (host names or IP addresses) that are considered safe for loading various types
of the resources from the Studio application. See Manage Safe Domains for more
information.

• Basemaps: This slider allows a quick view of the existing custom basemaps, and in
adding or editing custom basemaps. Custom basemaps can be made of either raster or
vector tiles, typically hosted on a third party tile server. Additionally, you can also create a
custom basemap using a WMS OGC web service.

• Cesium Basemaps: This slider gives you a quick view of the existing custom basemaps
used exclusively for the 3D Cesium Map visualization. It also allows you to add new
basemaps to be used by the 3D Map visualizations.

• Map symbols: This slider allows you to upload custom map symbols in Spatial Studio.
This option is available for both Spatial Studio administrators and regular users.

• My compute environment: This slider enables you to create a new dedicated compute
environment to meet your task requirements when working with Spatial Studio. See About
the Compute Environment in Spatial Studio for more information.

• Configuration File: This slider allows you to configure the cache size and maximum
dataset size for upload. See Set Cache and Dataset Files Upload Size Limits for more
information.

Note

Each listed host entry for Basemaps and Cesium Basemaps must be present as one
of the entries in the Safe Domains list. If the host basemap comes from a domain that
is not present in the Safe Domains list, then the basemap may not render correctly
when visualizing the map.

Security

Access Tokens: This slider allows you to create different types of access tokens. This option
is available for both Spatial Studio administrators and regular users.
See Create and Manage Tokens for more information.

Maintenance

• Refresh Coordinate System cache: Use this only when needed to rebuild the text index
of the repository database schema’s supported Spatial Reference Well Known Text
(WKText) definitions. For the shapefile upload, this WKText index is used to automatically
match the best SRID.

• Refresh Metadata Cache: Spatial Studio typically caches all of the frequently used
metadata such as the definitions of Datasets, Connections, and Projects. Sometimes it is
required to refresh the whole cache in case some cached metadata becomes stale or out
of sync in rare events.
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• Notifications: You can use this option to set up one or more system notifications. These
notifications are displayed across the top of the Spatial Studio application once a user logs
in.

• Restart tenant services: You can click this button to perform a soft reboot of the Spatial
Studio application without using command lines at the terminal. This action will internally
restart all components of the system. It can be helpful in resolving issues such as problems
with database connections due to extended network outages, jobs that appear to be stuck,
or when the system is not functioning properly. Note that this process may take a few
seconds to complete.

Monitoring

• Server Status: This section provides read-only information about the general health and
system status of the Spatial Studio server.

• Cache Status: This section provides the details of the cache maintained by Spatial Studio.

• Service Logs: This section allows loading and viewing a desired number of server-side
logs. To reduce the clutter, you can filter the result using the desired logging level. It also
allows the administrator to change the logging level. See View and Manage Server Logs
for more information.

Configure Custom Branding
As a Spatial Studio administrator, you can use the Brand Manager feature in Spatial Studio to
upload your brand logo and change the application title as desired.
The following steps enable you to configure custom branding.

1. Navigate to the Console page.

2. Click General under Settings.

The Brand Manager slider opens as shown.
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3. Select Custom from the Banner style drop-down list.

The following two banner styles are supported:

• Default: This is the default configuration which uses Oracle branding.

• Custom: Custom configuration allows you to apply your organization's branding.

4. Change the Application title as desired.

The default value is Spatial Studio.

5. Upload your own Application logo.

6. Enter your Application logo name.

7. Preview your changes and click Save Changes.

Note that you need to refresh your page to see the custom brand changes.

Configure Zip Upload Settings
Spatial Studio allows you to create datasets by uploading zip files. As a Spatial Studio
administrator, you can set the size limits for these zip files.
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Perform the following steps, to change the zip upload settings.

1. Navigate to the Console page.

2. Click General under Settings.

The General slider opens.

3. Click the Advanced Settings collapse icon to open the Zip Upload Settings as shown:

 

 

4. Change any of the following default configuration options as required.

• Maximum inflate multiplier: Maximum allowed multiplier when inflating files.

• Maximum unzipped item size (MB): Maximum size for an item in the zip file.

• Maximum unzipped total size (MB): Maximum size of the zip file (with all the entries
unzipped to the disk).

5. Click Save Changes.

Manage Safe Domains
As an administrator, you can add a domain of a custom basemap or a WMS service to the
Content Security Policy directives of your Spatial Studio application.
Alternatively, you can edit or delete an existing safe domain.

Note

If you make any changes to the safe domains list, then it is important that you refresh
or reload the browser page to reload the new Content Security Policy.
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1. Navigate to the Console page.

2. Click Safe Domains under Settings.

The list of safe domains to which Spatial Studio has access is displayed as shown:

You can choose to perform one of the following actions:

• Adding a safe domain

a. Click Add.
A new row gets added to the end of the safe domains table list.

b. Double-click the Domain Name cell of the empty new row to enter the new
domain.
Ensure that you enter only the domain part of an external URL (that is, the
protocol, host name or IP address, and port) from which you will be fetching the
resources. For instance, https://wms.mycompany.com:8080 or https://
wms.mycompany.com.

Note that the protocol is a part of the domain and should be based on the URL of
the remote service. For instance, if you defined a WMS data source or a custom
base map in Spatial Studio, and the URL to the WMS server or the custom base
map's tile server starts with https://, then you must use https://. If it starts with
http://, then use http://. In case if both the protocols are used (maybe one is
used to fetch some resources while the other is used for a different type of
resource), then you need to add the domain twice, one with the http:// protocol
and another with the https:// protocol. Spatial Studio performs safe domain
validation strictly based on the value you added to the list.

c. Select the appropriate check boxes.
The check boxes represent Content Security Policy fetch directives.
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– Connect: This corresponds to the CSP connect-src directive, and indicates
whether Spatial Studio is allowed to interact with the domain via script
interface (such as AJAX calls).

– Image: this corresponds to the CSP img-src directive, and indicates whether
Spatial Studio is allowed to fetch images from the domain.

– Script: this corresponds to the CSP script-src directive, and indicates
whether Spatial Studio is allowed to import or load scripts hosted by the
specified domain.

– Font: this corresponds to the CSP font-src directive, and indicates whether
Spatial Studio is allowed to load font data from the specified domain.

– CSS Style: this corresponds to the CSP style-src directive, and indicates
whether Spatial Studio is allowed to load stylesheet from the specified domain.

It is important to understand what type of resources you will be fetching from the
specific domain. For instance, if you select the check box Script, then it implies
that you are enabling your browser to fetch Java Script type resources from the
domain.

In case if you are adding a safe domain for a WMS data source, then you likely
need to enable the following check boxes:

– Connect: This is required because Spatial Studio needs to interact with a
remote WMS data source to check its capabilities using AJAX calls.

– Image: This is needed because eventually Spatial Studio needs to fetch
individual WMS map images from the remote WMS server.

Note that when a check box is selected, the domain URL gets added to a list of all
the allowed URLs for the corresponding CSP directive. For instance, consider that
the domain https://www.mycompany.com is added as a safe domain with the
Connect check box selected. Then, when you reload Spatial Studio, the CSP
header loaded by the browser will now include https://www.mycompany.com in its
connect-src directive's list of domain values.

d. Click Save Changes.

e. Ensure to refresh or reload the browser page.

• Editing a safe domain

– Double-click the required safe domain table row and edit the required details.

– Click Save Changes.

– Ensure to refresh or reload the browser page.

• Deleting a safe domain

– Double-click the required safe domain row in the table.

– Click  and confirm delete by clicking OK.

– Click Save Changes.

– Ensure to refresh or reload the browser page.

Add a Custom Basemap
The following steps enable you to add a custom basemap.

1. Navigate to the Console page.
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2. Click Basemaps under Settings.

The Basemaps window listing all the available basemaps opens.

3. Click Add Basemap and click on one of the following basemap types:

• XYZ Raster tiles

• OGC WMS

• Vector tiles

4. Enter Name and URL for the selected basemap type.

5. Optionally enter Attribution and API Key.

Tip

Once you have entered all the required fields, you can preview the basemap by
clicking Quick View.

6. Click Save to add the base map.

For example, the following figure show the OGC WMS basemap configuration window:
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Note

It is important to add the domain name to Safe Domains in order to enable the
Spatial Studio application to access the required service for the basemap.

Edit a Custom Basemap
The following steps enable you to edit a custom basemap.

1. Navigate to the Console page.

2. Click Basemaps under Settings.

The Basemaps window listing all the available basemaps opens.

3. Click  against the required custom basemap and click Edit from the context menu.

Note

Edit is disabled for predefined Spatial Studio maps.

The custom basemap configuration details are displayed for editing as shown:

4. Modify the required parameters, such as Name, Attribution, URL or API Key.

5. Click Save.

The custom basemap details are modified and the updates are shown in the Basemaps
window.
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Upload a Map Symbol
You can upload custom map symbols (or icons) and also 3D models (in .glb format), which you
can use in a Map or Cesium-Map visualization.

Also, note the following:

• All uploaded symbols are assigned a globally unique ID. The application always references
the symbol using its unique ID, and not by its name. The name of the symbol is used only
for display purposes in the application.

• When a regular user (non-administrator) uploads a map symbol, the symbol is visible and
accessible only for that specific user and does not become public.

• When an administrator uploads a map symbol, the symbol is accessible in a read-only
manner to everyone in the organization. The symbol will show up in the symbol list of any
regular Spatial Studio user along with their own symbols.

• Regular users can Rename and Delete only their own custom map symbols.

• If two different users upload an image file with the same name, then the symbols do not
get overwritten as each symbol is referenced by its unique ID.

• When an owner attempts to delete a custom map symbol, Spatial Studio performs a
referential check to ensure that the particular symbol is not used in any map visualization.

• The Copy symbol ID option can be used when the user wants to explicitly assign and
apply different custom symbols to different groups of data, in which case the symbol ID
needs to be stored in the source data table in its own column.

The following steps enable you to add a custom map symbol in Spatial Studio.

1. Navigate to the Console page.

2. Click Map symbols under Settings.

The Map symbols slider opens as shown.

3. Click the Custom symbols collapse icon and click Upload symbol.
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4. Select the required image file in your system for the upload.

It is important to note the following:

• Only .png, .gif, .jpg, and .glb file formats are supported.

• Each file cannot exceed 2 MB in size.

5. Optionally, change the Symbol name.

6. Click  to add the custom map symbol.

Once it is uploaded, you can style your data points on a map visualization using the new
symbol. See Apply Custom Map Symbols to a Map Layer for more information.

Create a Compute Environment
You can configure a new compute environment in Spatial Studio.

1. Navigate to the Console page.

2. Click My compute environment under Settings.

The My compute environment slider opens as shown:
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3. Optionally, adjust the Memory size in GB.

The default value is 10 GB.

4. Click Create.

Spatial Studio gets attached to the newly created compute environment. The Attached
status is displayed in green on the top right of the header.
It is recommended that you reload the application page to ensure consistency with the
newly established configuration.

Set Cache and Dataset Files Upload Size Limits
You can enable and configure the in-memory cache of your Spatial Studio objects. In addition,
you can define the size limit for dataset files uploaded in Spatial Studio.

1. Navigate to the Console page.
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2. Click Configuration File under Settings.

The Configuration File slider opens.
 

 

3. Perform the following actions as applicable.

• To enable and configure Cache Size
Set the following options as required:

– Enabled: Toggle to switch ON or OFF the caching of vector tiles. By default, cache
is enabled.

– Max Entries: Maximum number of entries to be cached. Default value is 20,000
entries.

– Max Age Seconds: Maximum time (in seconds) since the last update after which
an entry will be removed. Default value is 900 seconds.

• To configure Dataset Files Upload Size
Set Max Dataset Size which determines the maximum combined size of dataset files
allowed in an upload request. Default value is 2000 files.

4. Click Save Changes.

Create and Manage Tokens
Spatial Studio allows you to create different types of access tokens.

The following describes the supported token types:

• Access Tokens:
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– General-purpose token: Full access to all resources. The token grants read-only or
read-write access as required.
In most cases you should avoid using a general-purpose token as it grants too much
access. Instead, generate and use a specific token that applies to your scenario.

– Streaming-only token: Access only to REST endpoints related to dataset streaming.
Also, the token grants read-only access that be used only with HTTP GET methods.

– Streaming and tile refreshing token: The scope of this token is extended to refresh
the existing vector tiles of the streaming dataset on the recent updates.

– Embedding Published Projects token: This token allows embedding of private
published projects.

See Generating an Access Token to create the preceding access tokens.

• Access-Generator token: This is a special type of token that is used to
(programmatically) create short-lived access tokens (of types shown in the preceding list
under Access Tokens).
This token cannot be created or deleted directly. You can only copy the system generated
access-generator token. Note that the system generates this token on a per-user basis.
This implies that different Spatial Studio users will have different access-generator tokens.

Also, you can request Spatial Studio to regenerate the access-generator token for you.

– See Copy the Access-Generator Token to copy the token.

– See Generate Access Tokens Programmatically for using the access-generator token.

Generating an Access Token
To generate an access token:

1. Navigate to the Console page.

2. Click Access Tokens under Security.

The Access Tokens slider opens and the existing tokens are displayed.

3. Click Create New Token.

Create A New Access Token dialog opens as shown:
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4. Enter the token Name.

5. Enter the time Valid for (minutes) after which the token expires.

If you specify -1, then Spatial Studio will never expire the token, unless you explicitly
revoke it.

6. Select Resource type.

7. Optionally, select the Allowed action for granting access to a general-purpose token.

8. Click OK to create the token.

The token gets created successfully.

Generate Access Tokens Programmatically
Your web application can also create or obtain a short-lived access token from Spatial Studio
programmatically, by using an Access-Generator Token.

The following provides the Spatial Studio REST API endpoint details to create an access
token:

Endpoint: /spatialstudio/oauth/v1/user/token?
name=<NAME>&validTime=<MINUTES>&action=<ACTION>&resourceType=<RESOURCE>
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Required HTTP Request Header: Name of the header must be Authorization and its value
must start with Bearer followed by a space, then followed by a valid access-generator token
string.

The following table describes the query parameters used in the preceding endpoint.

Table 7-1    Query Parameters

Query
Parameters1

Data Type Description

name Up to 128 chars (non-null) Specifies the name of the token to be
created.

validTime An integer x, where -1 >= x >= 9999 Specifies for how many minutes the new
token remains valid.
Note: A value of -1 indicates that the
token will not expire.

action enum[read_only, read_write] Specifies the actions the new token is
allowed to perform.

resourceType enum[dataset_streaming,
dataset_streaming_refreshing ,
embedded_published_project, all

Specifies the types of resources the new
token is allowed to access (act on).

1 All the query parameters are mandatory.

It is important to note that currently only five different types of tokens can be created with the
following combinations of action and resourceType:

• action=read_only&resourceType=all

• action=read_write&resourceType=all

• action=read_only&resourceType=dataset_streaming

• action=read_write&resourceType=dataset_streaming_refreshing

• action=read_only&resourceType=embedded_published_project

Any other combination of action and resourceType (outside the valid combinations shown in
preceding list) will be rejected.

The following shows a sample request (using Curl command line) to obtain an access token
that allows a web application to get the streaming access to a dataset as well as allowing the
refreshing of the dataset’s vector tiles.

curl -X POST 'http://localhost:8080/spatialstudio/oauth/v1/user/token?
name=test123&validTime=60&action=read_write&resourceType=dataset_streaming_refres
hing' --header 'Authorization: Bearer $GENERATORTOKEN'

The preceding request returns a JSON document containing the new token. Its value is stored
in the token field in the response:

{"name":"test123","token":"eyJ0eXAiOiJzZ3RlY2...", … }

Copy the Access-Generator Token
Perform the following steps to copy the access-generator token:

1. Click  on the top right corner of the page.
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2. Click Access Tokens from the drop-down menu.

The Access Tokens dialog opens.

3. Click Show Access-Generator Token.

The Access-Generator Token dialog opens which shows the existing access-generator
token.

4. Click Copy Token to copy the token string.

5. Optionally, click Regenerate Token to request the system to regenerate the access-
generator token, and then copy the token.

Manage System Notifications
As the Spatial Studio administrator, you can create, edit, or delete system notifications.
Spatial Studio supports two types of notifications:

• Banner: These notifications are typically used to display informative message such as
planned downtime, scheduled updates, and so on. Banner type notifications are displayed
across the top of the web application page, just above the built-in Spatial Studio application
banner.

• Show Stopper: These are messages that will be displayed when the Spatial Studio server
is not servicing any requests such as when being investigated for emergency issues or
breaches.

You can manage the system notifications as shown in the following steps:

1. Navigate to the Console page.

2. Click Notifications under Maintenance.

The Notifications window listing all the configured notifications opens.

3. Perform any one of the following required actions.

• Create a New Notification

a. Click Create.

b. Select the Notification Type.

c. Enter Severity, Expiration Date (in UTC), and Message for banner notifications.

d. Enter Title, Expiration Date (in UTC), and Message for show stopper
notifications.

e. Click OK.

The new notification appears in the Notifications dialog.
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• Edit a Notification

Click  against a notification to edit the message details.

• Delete a Notification

Click  against a notification to delete the notification.

View and Manage Server Logs
As the Spatial Studio administrator, you can always view the most recent log messages
generated by the server in your Spatial Studio application.

Perform the following steps to view and manage these server logs.

1. Navigate to the Console page.

2. Click Service Logs under Monitoring.

The Service Logs slider opens as shown.

Figure 7-1    Service Logs

3. Optionally, configure any of the following fields to customize the logs that are fetched from
the server.

• Total entries: This limits how many log messages or records will be loaded from the
server.

• Crop entries: If switched ON, then any log message with a very long string will be
cropped when viewed.
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• Entries’ length: This determines the crop length.

• Filter by log level: This drop-down list allows you to filter the server logs so that only
those logged at the selected level or higher (more severe in nature) will be fetched
from the server for display.
The supported log levels are:

– ERROR

– WARN

– INFO

– DEBUG

– TRACE

• Load Logs: Click this button to reload the logs from the server when you change any
of the preceding configurations.

4. Optionally, click Change Logging Level to change the server's logging level.

Change Logging Level window opens as shown.

The Change Logging Level button allows the administrator user to dynamically change
the logging level used by the server without restarting it.

Sometimes it may become necessary to change the logging level, so that the Spatial
Studio server can log more or less messages, or generate DEBUG or TRACE level messages
for a specific functional area in order to diagnose a certain issue. By default, Spatial Studio
uses the INFO log level, which means only log messages generated at the level INFO, WARN,
or ERROR will be written to the log file (default location is <OS_USER_HOME_DIR>/.sgtech/
logs/sgtech.log).

a. Optionally, change any of the following configuration.

• Package name: This specifies the area of the server that will be affected by the
new logging level. If you specify ROOT (the default value), then the new logging
level will affect all areas or functions of the Spatial Studio server. However, you
can also enter a specific Java package name (maybe based on suggestions from
your Oracle Support team), such as oracle.sgtech.jee.api when debugging
issues related to Spatial Studio instance’s REST API end points. When a specific
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package name is entered, then the new log level will only take effect when code
from that package is executed.

• New Log Level: This drop-down list allows you to select the new log level to be
applied to the server’s specific package or the entire server (default ROOT).

b. Click OK.

Note that the log files may take a while to be filled with the messages logged at the
new level.
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8
Work with Visualization

You can visualize your spatial data in Oracle Spatial Studio using three different modes of
visualization - Table, Map, and Cesium-Map.

You can save your visualization as a Project in Spatial Studio. You can rework on a project or
publish a project to share the results with other users.

Topics:

• Use a Table Visualization

• Use a Map Visualization

• Configure a Map Visualization

• Filter Data on a Map Layer

• Add Interactions to a Map Visualization

• Changing the Pitch and Bearing of a Map

• Search Locations and Features on a Map

Use a Table Visualization
Spatial Studio allows you to visualize your data from the dataset in tables.

To display your data in a tabular view, you must perform the following steps.

The instructions assume that the dataset for visualization is already added to the project in the
Active Project page.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Table from the list to the visualization window on the right to create a table
visualization.

This opens an empty layer in the visualization window.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Click and drag the desired dataset from the list to the empty layer on the right.

Note

You can view only one dataset in a table view. If you want to view multiple
datasets, you must create one table view for each dataset.

Using Oracle Spatial Studio on Autonomous AI Database
G40399-01
Copyright © 2021, 2026, Oracle and/or its affiliates.

April 10, 2026
Page 1 of 37



This opens the data in tabular format for visualization as shown:

You can easily scroll up or down the table to view the data rows as the table supports
infinite scrolling.

5. Optionally, click the table Settings and enable Show only selected features to display
the table rows for only the features selected on the map.

For example, the following figure shows both a map and table visualization. The Show
only selected features setting is enabled for the table. Therefore, the table displays only
three rows of data corresponding to the three selected features (shown highlighted) on the
map.
 

 

6. Optionally, you can directly zoom map on the selected features from the table visualization
as shown in the following steps:

a. Select the required table rows.

b. Click on the map to get the map focus.

c. Click  against the corresponding map layer in the Layers list of the Layers tab.
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d. Click Zoom and select Selected Features in the context menu.

The map zooms in on the selected table row(s), which are highlighted as shown in the
following example visualization:

 

 

Use a Map Visualization
Spatial Studio supports several types of map visualizations such as geometry data
visualization (points, lines, polygons), GeoRaster data visualization, hexagonal data
visualization using H3 aggregations, and so on.

Topics:

• Visualize a Point Map

• Visualize GeoRaster Data on a Map

• Visualize Spatiotemporal Datasets

• Visualize OGC WMS Maps as a Dataset

• Visualize Data With H3 Aggregations

• Visualize Custom Map Regions

• Visualize a Wind Animation Dataset

Visualize a Point Map
Spatial Studio allows you to visualize the location of geographic data as points on maps.

To display your geographic data as maps, you must perform the following steps.

The instructions assume that the dataset for visualization is already added to the project in the
Active Project page.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.
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This lists all the Datasets that are loaded for the project.

4. Click and drag the desired dataset from the list to the map view on the right.

Tip

You can drag and drop multiple datasets in a single action to your map view.

The map layer displays the data points for visualization.

5. Optionally, you can click Settings in the map tool bar and enable Show minimap in the
Visualization Settings dialog.

An inset map showing the overview of the main map is displayed as shown in the
preceding figure.

See Also

Apply a Render Style For a Point Layer to render your map using different
rendering styles.

Visualize GeoRaster Data on a Map
Oracle Spatial Studio allows you to visualize GeoRaster data stored in spatial GeoRaster type
in Oracle Database. Geo-referenced raster data, including satellite imagery, aerial photos from
drones, and gridded data, is very useful for mapping applications. It can be directly analyzed,
or layered with vector data as a background map for additional context. See Spatial GeoRaster
Developer's Guide for more information on GeoRaster data.

You can visualize georaster data on a map using the following steps.

The instructions assume that the GeoRaster dataset is already added to the project in the
Active Project page. To create a GeoRaster dataset, see Create a GeoRaster Dataset for more
information.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.
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2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Click and drag the desired GeoRaster dataset from the list to the map view on the right.

A GeoRaster layer is created on the map as shown:

Tip

You can enhance your visual display by modifying your Layer Settings using the
Style tab and Raster tab.

Spatial Studio also supports visualization of 3D terrains on a map using GeoRaster Digital
Elevation Model (DEM) data. See Apply Style for a GeoRaster Layer for more information.

Visualize Spatiotemporal Datasets
You can visualize spatiotemporal datasets using the Cesium Timeline widget.

The following sections provide more information on the Cesium Timeline widget and the
supported visualizations.

Overview of the Cesium Timeline Widget
Spatial Studio provides a new standalone Cesium Timeline widget.
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The Cesium Timeline widget in Spatial Studio provides the following capabilities:

• Dataset filtering.

• Serves as a hub for controlling all kinds of spatiotemporal data (such as live, historic,
moving objects, and so on).
The only exception being the GeoJSON URL based datasets. These datasets do not cater
to Cesium timeline as the external URLs may not have the capability to provide GeoJSON
corresponding to a time value, but are rather simply refreshed to provide newer values
every x seconds.

• Offers a scalable solution to add multiple layers of different dataset types at once that can
be time-synced as required.

The following figure shows the Cesium Timeline Widget on a map visualization in Spatial
Studio.

The key concepts of the Cesium Timeline are as follows:

• Cesium Timeline Modes: The timeline supports two modes of operation. If even one layer
corresponding to a live dataset is listening to the timeline, then the mode of operation is
LIVE. Otherwise, the mode of operation is always HISTORIC.

• Cesium Clock Start Time: Starting point of the current range of timeline. This is the point
in time from which the Cesium clock starts ticking.

• Cesium Clock Stop Time: Ending point of the current range of timeline. This is the point
in time until which the Cesium clock ticks. However upon reaching the end, the timeline
behavior depends on the mode:

– LIVE: The timeline will move ahead by updating the start time and stop time values as
per the current time.

– HISTORIC: The timeline will loop back to the start time.

• Cesium Clock Current Time: The current time frame of the clock. It begins at the Cesium
clock start time and ticks every 500ms. Optionally, you can slide the pointer on the timeline
manually to set your current time.
Also note the following with respect to the type of the spatiotemporal dataset:

– Live Spatiotemporal Dataset: The Cesium clock current time value for such datasets
is configured to always be pointing to current UTC time (unless manually changed).

– Non-Live Spatiotemporal Dataset: If no other dataset is added to the timeline, then
the Cesium clock for such a dataset automatically sets its range to minimum and
maximum of the timestamp column, and the Cesium clock current time starts from the
minimum value.

• Multiplier: Multiplies to the interval at which the clock ticks (500ms) in order to make the
clock jump ahead or rewind accordingly.

• Timeline Playback Controls:

1. Pause: Stops the timeline from animating and throwing tick events. The timeline
pauses at current timeline frame.

2. Forward and Backward Play Buttons: Makes the timeline animate in the chosen
direction and includes the multiplier value (+/- Multiplier * 500ms)

• Cesium Timeline settings: Allows you to control the timeline settings.
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Related Topics

• Configure Cesium Timeline Settings
You can configure custom settings for the Cesium timeline.

• About Map Layers and the Timeline
Learn more about the spatiotemporal map layers and the Cesium timeline.

Configure Cesium Timeline Settings
You can configure custom settings for the Cesium timeline.

Perform the following steps to configure the Cesium Timeline settings in your map
visualization.

The instructions assume that you have a project linked to a spatiotemporal dataset and the
project is opened on your Active Project page.

1. Click the Settings icon in your map tool bar.

2. Switch ON the Show timeline toggle and click OK.

The Cesium Timeline widget appears at the bottom of the map visualization canvas.

3. Click  on the timeline to configure the Cesium timeline settings.

The Timeline Settings dialog opens as shown:

Chapter 8
Use a Map Visualization

Using Oracle Spatial Studio on Autonomous AI Database
G40399-01
Copyright © 2021, 2026, Oracle and/or its affiliates.

April 10, 2026
Page 7 of 37



a. Select the Start Time and Stop Time to set the timeline range.

b. Enter or select a multiplier value from the Type or select Multiplier value list box.

You can use a preset (Second, Minutes, Hours, Days, Weeks, Month, Year) multiplier
or type a value such as 15 or 15x.

c. Select the Display Time Zone in which you want the Cesium timeline to display its
current time and timeline labels.

d. Optionally, switch ON the Autohide time of day.

If you opt to autohide time of day, then the time values from the timeline labels are
hidden if the timeline range selected is greater than a week.

e. Click Apply.

About Map Layers and the Timeline
Learn more about the spatiotemporal map layers and the Cesium timeline.

• In order to add a map layer to the timeline, you must first enable spatiotemporal in the
underlying dataset for the map layer. See Enable Spatiotemporal for a Dataset for more
information.

• You can then add one or more spatiotemporal map layers to the Cesium timeline by
performing the following steps:

– Click the Settings icon in your map tool bar and switch ON the Show timeline toggle to
view the Cesium timeline widget at the bottom of the map visualization canvas.

– Select the Add to Timeline option in the context menu of the map layer as shown:

The map layer gets added to the timeline.

• Note the following if you add multiple map layers to the timeline:
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– Each of these map layers respond to the timeline events independently. Therefore, you
can configure each map layer to have its own properties (such as refresh time) and
they then accordingly respond to the listener events. As the timeline events are thrown
at every 500ms tick interval, each layer can have it own refresh time (more than 500ms)
as to when they want to respond to these events.

– Also, in case of the map layers for datasets with historic timestamp values, all layers
will loop back as per the current timeline range. This may either correspond to the first
layer added to the timeline or it can be a custom range that you set in the timeline
settings.

– If a layer corresponding to a live dataset is added to the timeline, then irrespective of
the historic dataset layers listening to the timeline already, the timeline will never loop
back and will keep moving forward.

• If you make any changes to the underlying dataset properties of a map layer, which is
already added to the timeline, such as:

– * Disabling the Enable Spatiotemporal toggle

* Toggling Data is Live and Moving Objects

Then, the listener gets removed from the timeline. In such cases, it is recommended
that you remove the layer from the timeline and add it again after changing the
properties.

– If you change the Time Unit property of a standard filtering dataset, then this will take
effect immediately and the filtering on the map visualization will adhere to the new
Time Unit value.

Visualize Live Moving Objects Dataset
You can visualize live moving objects on a map in Spatial Studio.

The following instructions assume that you have enabled spatiotemporal for such a dataset
and the dataset is already added to the project in the Active Project page. See Configure
Spatiotemporal for Live Moving Objects Dataset for more information.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Click and drag the desired spatiotemporal dataset from the list to the map view on the
right.

Two map layers belonging to the dataset are created on the map. The second layer
representing the trails of the moving object is added automatically in Spatial Studio. See 
Characteristics of Spatiotemporal Map Layers for Moving Objects Dataset for more
information on the two map layers.

5. Click the Settings icon in your map tool bar.

6. Switch ON the Show timeline toggle and click OK.

The Cesium timeline widget appears at the bottom of the map visualization canvas.
However, the timeline is not operational at this step.
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7. Click  against the primary layer in the Data tab of the Layers list and click Add to
Timeline,

Adding a map layer to the timeline will point to the current UTC time and the layer is now
listening to the timeline events. However, the timeline is not operational at this step.
Optionally, repeat this step to add multiple layers (of different spatiotemporal datasets) to
the timeline and listen to its events.

8. Configure animation for the map layer by following the steps in Configure Animation for
Moving Objects Dataset.

9. Select Zoom Timeline to Range in the context menu of the map layer.

The timeline is refocused on current UTC time.

10. Optionally, configure custom Start Time, Stop Time, Multiplier, and so on from the
timeline settings. You can also use the Cesium timeline controls and make the current time
pointer slide to a different timeframe.

11. Optionally, select Remove from Timeline in the context menu of the map layer if you wish
the map layer to stop listening to the Cesium timeline.

Visualize Live and Non-Moving Objects Dataset
You can visualize a spatiotemporal dataset having ongoing inserts of real-time data, but the
locations of the data entities do not change.

The following instructions assume that you have enabled spatiotemporal for such a dataset
and the dataset is already added to the project in the Active Project page. See Configure
Spatiotemporal for Live and Non-Moving Objects Dataset for more information.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.
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This lists all the Datasets that are loaded for the project.

4. Click and drag the desired spatiotemporal dataset from the list to the map view on the
right.

Two map layers belonging to the dataset are created on the map.

5. Click the Settings icon in your map tool bar.

6. Switch ON the Show timeline toggle and click OK.

The Cesium Timeline widget appears at the bottom of the map visualization canvas.
However, the timeline is not operational at this step.

7. Click  against the primary layer in the Data tab of the Layers list and click Add to
Timeline.

8. Select Configure Animation from the context menu of the map layer.

9. Switch ON Animate layer based on automatic dataset refresh.

The dataset animates with the Cesium clock events.

10. Specify Time between auto refreshes to indicate the frequency of data refresh from the
backend. This configuration also determines the smoothness and speed of the temporal
animation.

Also, note the following:

• Spatial Studio displays a default frequency value which is same as the Data Change
Rate value configured on the Spatiotemporal dataset used for the visualization.

• Only one dataset layer for the geometry animates (attributes change) as per the
Cesium clock's current time (which points to the present UTC time value) and the
multiplier value (default is 1x). Since the dataset is a streaming entity it will not have
data ahead of time. Hence you must not change the default Cesium clock values. If
you expect the data to be updated every x minutes, then configure Time between
auto refreshes to x minutes, but do not change the Cesium timeline range or the
multiplier value.

11. Select Zoom Timeline to Range in the context menu of the map layer to make the
timeline reset to current clock time and a 1x multiplier.

Upon reaching the set end time, the timeline will keep moving ahead and will not loop
back.

12. Optionally, select Remove from Timeline in the context menu of the map layer if you wish
the map layer to stop listening to the Cesium timeline.

Visualize Non-Live Moving Objects Dataset
You can visualize moving objects with historic timestamp values on a map in Spatial Studio.

The following instructions assume that you have enabled spatiotemporal for such a dataset
and the dataset is already added to the project in the Active Project page. See Configure
Spatiotemporal for Non-Live Moving Objects Dataset for more information.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.
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3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Click and drag the desired spatiotemporal dataset from the list to the map view on the
right.

Two map layers belonging to the dataset are created on the map. The second layer
representing the trails of the moving object is added automatically in Spatial Studio. See 
Characteristics of Spatiotemporal Map Layers for Moving Objects Dataset for more
information on the two map layers.

5. Click the Settings icon in your map tool bar.

6. Switch ON the Show timeline toggle and click OK.

The Cesium Timeline widget appears at the bottom of the map visualization canvas.
However, the timeline is not operational at this step.

7. Click  against the primary layer in the Data tab of the Layers list and click Add to
Timeline.

The map layer gets added to the timeline and the timeline will range from minimum value
to maximum value of the timestamp column. the current time will point to the min value of
the timestamp column and the layer is now listening to the timeline events. However, the
timeline is not operational at this step. Optionally, repeat this step to add multiple layers (of
different spatiotemporal datasets) to the timeline.

8. Configure animation for the map layer by following the steps in Configure Animation for
Moving Objects Dataset.

9. Select Zoom Timeline to Range in the context menu of the map layer.

The timeline is refocused to range from minimum value to maximum value of the
timestamp column and current time will point to the minimum value of the timestamp
column. This acts as a looping mechanism for a historic dataset.

10. Optionally, configure custom Start Time, Stop Time, Multiplier, and so on from the
timeline settings. You can also use the Cesium timeline controls and make the current time
pointer slide to a different timeframe.

11. Optionally, select Remove from Timeline in the context menu of the map layer if you wish
the map layer to stop listening to the Cesium timeline.

Visualize Non-Live and Non-Moving Objects Dataset
You can visualize a spatiotemporal dataset that simply contains different timestamp values in
each row which are not grouped by any entity ids.

The following instructions assume that you have enabled spatiotemporal for such a dataset
and the dataset is already added to the project in the Active Project page. See Configure
Spatiotemporal for Non-Live and Non-Moving Objects Dataset for more information.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.
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4. Click and drag the desired spatiotemporal dataset from the list to the map view on the
right.

A single map layer is created on the map.

5. Click the Settings icon in your map tool bar.

6. Switch ON the Show timeline toggle and click OK.

The Cesium Timeline widget appears at the bottom of the map visualization canvas.
However, the timeline is not operational at this step.

7. Click  against the primary layer in the Data tab of the Layers list and click Add to
Timeline.

The map layer gets added to the timeline and the timeline will range from minimum value
to maximum value of the timestamp column. The current time will point to the minimum
value of the timestamp column and the layer is now listening to the timeline events.
Also, the filtering configured for the spatiotemporal settings will automatically be applied
and the map layer will be filtered as per the Cesium clock current time. For example, if the
Cesium clock current time is Monday, May 22, 2023 5:13 PM and the configured time unit
for filtering is month, then the map visualization will show all the geometries that have the
timestamps between May 1, 2023 and May 31, 2023.

The multiplier of the timeline matches the filtering time unit selected. However, you can
also change the time unit at which the dataset is currently being filtered (see Configure
Spatiotemporal for Non-Live and Non-Moving Objects Dataset).

8. Select Zoom Timeline to Range in the context menu of the map layer.

The timeline is refocused to range from minimum value to maximum value of the
timestamp column and the current time will point to the minimum value of the timestamp
column. This acts as a looping mechanism for a historic dataset.

9. Optionally, select custom Start Time, Stop Time, Multiplier, and so on from the timeline
settings. You can also use the Cesium timeline controls and make the current time pointer
slide to a different time frame.

10. Optionally, select Remove from Timeline in the context menu of the map layer if you wish
the map layer to stop listening to the Cesium timeline.
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Visualize Spatiotemporal Data in OGC WMS Datasets
You can visualize OGC WMS datasets that contain spatiotemporal data.

The following instructions assume that you have enabled spatiotemporal for such a dataset
and the dataset is already added to the project in the Active Project page. See Configure
Spatiotemporal for OGC WMS Datasets for more information.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Click and drag the desired spatiotemporal dataset from the list to the map view on the
right.

A single map layer is created on the map.

5. Click the Settings icon in your map tool bar.

6. Switch ON the Show timeline toggle and click OK.

The Cesium Timeline widget appears at the bottom of the map visualization canvas.
However, the timeline is not operational at this step.

7. Click  against the map layer in the Data tab of the Layers list and select Add to
Timeline.

The map layer gets added to the timeline. Although the timeline is now listening to the
timeline events, it is still not operational.

8. Select Configure Animation from the context menu of the map layer.

The animation configuration dialog opens as shown:
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9. Switch ON Animate layer based on automatic dataset refresh.

The dataset animates with the Cesium clock events.

The dataset will poll the WMS service to fetch the images as per the time value under the
Cesium clock current time.

10. Specify Time between auto refreshes to indicate the frequency of data refresh from the
backend. This configuration also determines the smoothness and speed of the temporal
animation.

Also, note the following:

• Spatial Studio displays a default value of 2 seconds for WMS datasets. The effective
refresh rates depend on how fast images are fetched from the respective WMS
service. Empirically, for WMS data, any data change rate less than 2 seconds is not
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sufficient to retrieve image and refresh the tiles. It can cause incomplete image loading
before the new refresh, or the visualization may remain stuck in refresh state.

• The parameter ignores all the tick events from the timeline if the Cesium clock current
time is less than previousRefreshTime + x seconds (or any other time unit). For
example, if a dataset is supposed to refresh every 30 seconds, then configure this
value in Time between auto refreshes so that even if the Cesium clock continues to
throw tick events for all layers, this layer will ignore any such events.

11. Specify a Time Unit.

12. Optionally, select custom Start Time, Stop Time, Multiplier, and so on from the timeline
settings. You can also use the Cesium timeline controls and make the current time pointer
slide to a different time frame.

Note

Zoom Timeline to Range is disabled for an OGC WMS dataset. This is because
each WMS dataset may comprise more than one image layers and it will be
inaccurate to choose a time range for any one of these layers automatically.
Therefore, use the Cesium timeline settings (see Configure Cesium Timeline
Settings) to manually set the appropriate range of the timeline for the specific
image layer that you wish to animate.

13. Optionally, select Remove from Timeline in the context menu of the map layer if you wish
the map layer to stop listening to the Cesium timeline.

Visualize GeoJSON URL Datasets with Spatiotemporal Data
You can visualize GeoJSON URL based datasets that contain spatiotemporal data.

The following instructions assume that you have enabled spatiotemporal for such a dataset
and the dataset is already added to the project in the Active Project page. See Configure
Spatiotemporal for GeoJSON URL Datasets for more information.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Click and drag the desired spatiotemporal dataset from the list to the map view on the
right.

A single map layer is created on the map.

5. Click  against the map layer in the Data tab of the Layers list and select Configure
Animation.
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Note

GeoJSON URL based datasets are not dependent on the time values represented
by the Cesium Timeline. They are just required to refresh periodically and
therefore you need not enable the Cesium Timeline for such datasets.

6. Switch ON Animate layer based on automatic dataset refresh.

7. Specify Time between auto refreshes to indicate the frequency of data refresh from the
backend. This configuration also determines the smoothness and speed of the temporal
animation.

The GeoJSON URL map layer is set to refresh periodically based on this configured
interval value.

Configure Animation for Moving Objects Dataset
You can animate a spatiotemporal map layer of a moving objects dataset based on Cesium
map events.

The instructions assume that the spatiotemporal map layer is already added to the Cesium
Timeline.

1. Click  against the primary layer in the Data tab of the Layers list.

The context menu of the map layer displays the following options:

2. Select Configure Animation.

The animation settings for the map layer opens.

3. Switch ON Animate layer based on automatic dataset refresh.

The dataset animates with the Cesium clock events.

4. Specify Time between auto refreshes to indicate the frequency of data refresh from the
backend. This configuration also determines the smoothness and speed of the temporal
animation.
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Also, note the following:

• Spatial Studio displays a default frequency value which is same as the Data Change
Rate value configured on the Spatiotemporal dataset used for the visualization.

• All the map layers added to the timeline can individually have their own refresh or
animation intervals.

• The parameter ignores all the tick events from the timeline if the Cesium clock current
time is less than previousRefreshTime + x seconds (or any other time unit). For
example, if a dataset is supposed to refresh every 30 seconds, then configure this
value in Time between auto refreshes so that even if the Cesium clock continues to
throw tick events for all layers, this layer will ignore any such events.

5. Specify a Time Unit.

6. Specify How much data to load, the trail length of your moving object. A trail length value
of N indicates that Spatial Studio must fetch the recent N units (unit value as specified in the
following step) of data of the moving object during every refresh.

Tip

If the underlying database table or view contains millions of records, you can limit
the map animation to display only the most recent N units of data as configured in
Trail Length.

Note that Spatial Studio displays a default trail length value which is 15 times the Data
Change Rate value configured on the Spatiotemporal dataset and is rounded to the
nearest integer.

7. Specify a Time Unit for the trail length.

The animation settings are configured and you can view the animation of moving objects
on the map.

Note

You can choose a symbol and color for your moving object. However, ensure that
the symbol you select adheres to the conditions explained in Characteristics of
Spatiotemporal Map Layers for Moving Objects Dataset.

Characteristics of Spatiotemporal Map Layers for Moving Objects Dataset
This section describes the distinct characteristics of the primary and secondary map layers
when visualizing a spatiotemporal dataset containing moving objects.

• The trails map layer is considered the secondary layer to the main layer. If you delete the
main layer from the map, then the trails map layer is automatically deleted as well.

• The main layer which shares the same name as the dataset is always a Point-type layer,
that you can visualize using either as circle or using symbols or icons. When you use
symbols, Spatial Studio will also automatically rotate the symbol based on the direction
your object is moving.
Also note, the current release of Spatial Studio supports only those symbols that naturally
point North (or point up) or those that do not represent an inherent direction or angle, such
as any rounded symbols.
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• The main layer will keep its animation even when you toggle the secondary layer invisible.
However, if you toggle the main layer invisible, the trail layer will remain static as no new
data is fetched from the backend.

• You cannot switch the main layer to Heatmap or Cluster type.

• You cannot use sticky Tooltip or popup as they cannot stick to the moving object when it
moves to new locations.

• Spatial Studio drives the animation of moving objects and their trails by constantly
refreshing the main layer’s data from the backend. This implies that the base table is
queried and the last N seconds of data is fetched by filtering the records based on the
TIMESTAMP column.

• If you are working in a multi-user or multi-visualization environment or both, you must take
care to avoid overloading the database with many animating layer's data refresh queries.
For instance, ensure a layer is not refreshing its data too frequently, or fetching too many
seconds of data on each refresh, or both.

Visualize OGC WMS Maps as a Dataset
You can visualize an OGC (Open Geospatial Consortium) WMS (Web Map Service) dataset on
a map.

This is in addition to creating a custom basemap that is based on external WMS maps, and
switching to such a basemap in your map visualization. The main issue in using basemaps is
that a single map visualization can only have one basemap. For instance, if you are using a
basemap based on WMS images, then you can no longer display other background maps,
such as OpenStreetMap. Therefore, the geographic context is lost as the WMS images
typically do not contain detailed administrative boundaries, or other common features seen on
a regular background map.
To overcome this limitation, Spatial Studio allows you to use a regular background map, while
adding the WMS map images as a dataset layer on top. As the WMS images are just another
dataset, which can be displayed as another layer on the map, you can easily reorder the
layers, or toggle the visibility of the WMS images just like with any other map layer.

To visualize an OGC WMS dataset on a map, you must perform the following steps.

As a prerequisite ensure the following:

• The OGC WMS dataset is created using an OGC WMS connection and exists in Spatial
Studio. See Create an OGC WMS Dataset for more information.

• The required OGC WMS dataset is added to the project in the Active Project page.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Drag and drop the desired OGC WMS dataset from the list to the map view on the right.

The OGC WMS data layer gets displayed on the map. The map will automatically zoom to
the area covered by the WMS dataset if it is the very first dataset to be added to your map.
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The preceding figure illustrates the weather pattern images (loaded from a WMS service)
which are overlaid on top of the OpenStreetMap background.

Tip

Click the Image link on the map legend to view the legend information generated
by the WMS service for the OGC WMS map layer.

Note

When you display a new WMS dataset for visualization, your browser will be
sending the WMS image requests directly to the WMS server. You can always
refresh the map layer to reflect the current data from the WMS server.

Related Topics

• Create an OGC WMS Dataset
Spatial Studio allows you to define datasets that are based on the GetMap responses from
any external OGC (Open Geospatial Consortium) WMS (Web Map Service) services.
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Visualize Data With H3 Aggregations
Oracle Spatial Studio allows you to visualize point-type map data using hexagons with H3
(Hexagonal Hierarchical Spatial Index) aggregations.

Visualizing your map data as hexagons has several advantages:

• It helps you to identify patterns or clusters in a larger point dataset

• Easier interpretation of data, as in a hexagonal cell, all the points are equidistant from the
hexagon center-point

• Hexagonal cells are color coded based on the number of datapoints they hold, which
enables you to easily understand data patterns

To visualize your map data with H3 aggregations, you must perform the following steps.

The instructions assume that an H3 aggregation dataset is already added to the project in the
Active Project page.
To prepare a dataset for H3 aggregation, see Prepare an H3 Aggregation Dataset for more
information.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Click and drag the desired H3 Aggregation dataset from the list to the map view on the
right.

A layer showing the hexagonal binning of the data points is displayed on the map as
shown:
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See Apply Data-Driven Style to a Map with H3 Aggregations for more information on
applying styling for a H3 map layer.

Visualize Custom Map Regions
Oracle Spatial Studio allows you to create custom map regions on map layers that support
polygon type geometry.

You can create a new map region by selecting multiple polygon shapes and combining them
with a new key-value. You can then append or insert this new map region with the new key-
value into a target dataset containing all of your other custom map regions, or save it as a new
dataset.

These newly created custom shapes are persisted on the underlying database table of the
target dataset, and therefore can be used for data visualization or reporting just like any other
dataset.

The following are the main characteristics for this feature support:

• The source dataset, that is the dataset whose polygon shapes you will be selecting and
then combining into a custom map region, must always be based on an Oracle Database
table.
Datasets from Oracle views and Studio's Analyses are not currently supported.

• The new regions may or may not be contiguous.

• The target dataset, that is the dataset on which you want to store the newly created
custom map regions, will store them in its geo-reference system.

• The target dataset can be a new dataset or an existing dataset in the current project. For a
new dataset, you need to specify the connection, the table name, the dataset name, the
key-column name of the table, and provide the key value for the new region.

• Only the key value and new geometry value are inserted into the newly created target
table. For inserting the new region into an existing dataset, you may provide values for all
of the dataset's attributes, or only the required ones.

• An existing targets dataset must meet the following requirements:

– The geometry metadata information for the target dataset must be available in the
SDO_GEOM_METADATA view.

– A spatial index must exist on the geometry column. Note that if a spatial index is not
created on the geometry column, then the target data layer cannot be dragged on to
the map visualization canvas.

• For a new target dataset, once it is created and the first region is inserted, then the dataset
can be manually added to the current active project and added as a layer to the map
visualization. For subsequent processing, this new target dataset is treated as an existing
target dataset.

Create Custom Regions for Visualization
You can create custom polygon regions on the source dataset that contains polygon type
geometries and apply them on a target dataset using the follow steps:

The instructions assume that the source and target datasets are already added to your Project
in the ActiveProject page.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.
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2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Click and drag the desired source dataset from the list to the map view on the right.

A map layer with polygon shapes is created.

5. Create the required custom regions by performing the following steps as many times as
required:

a. Select the regions for aggregation using the polygon selection tool in the map tool bar.

Tip

Alternatively, you can also select multiple polygons by using the keyboard
shortcut Ctrl + Click on a Windows system.

b. Click  , Actions icon on the map tool bar and select Create Custom Region.
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Combining shape dialog opens as shown:

c. Select the source dataset from the Combine shapes in drop-down list.

d. Select one of the following desired options for Target dataset:

• Create new: To create a new target dataset:

i. Enter Connection, Table name, and Dataset name details for the new target
dataset.

ii. Enter the Key column name and the Key value that uniquely identifies the
custom map region.

• Append to existing: To append the custom polygon shapes to an existing target
dataset:

i. Select an existing target dataset from the Append result to dataset drop-
down list.

ii. Click Enter new shape attributes and enter a unique key value for the Key
column name of the target dataset.
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e. Optionally, switch on or off the Include only selected items toggle button:

Caution

The whole source dataset may be aggregated into one region if Include only
selected items is switched off. In this case the process may run for a long
time depending on the number of features in the source dataset. Therefore,
use this option only if required.

f. Click OK to create the custom map region.

6. Drag and drop the target dataset to the map view on the right to view the newly created
custom regions.

The following figure shows the newly defined custom regions that were inserted into the
target dataset.

Create a Target Dataset
There are two ways to create a target dataset:

• By Spatial Studio: Refer to the Create new target dataset option in the earlier section.
Note that you must specify the key column name for the target dataset as the key values
are stored in the key column names for the corresponding geometries (custom map
regions).

• By manual process: Perform the following steps to create a dataset manually:

1. Connect to an Oracle database schema using SQL Developer or any other tools.

2. Create a spatial table as shown:

CREATE TABLE affected_regions (region_id NUMBER PRIMARY KEY, geom 
SDO_GEOMETRY);
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3. Insert the spatial table into USER_SDO_GEOM_METADATA view. For example:

INSERT INTO USER_SDO_GEOM_METADATA VALUES (
'affected_regions', -- TABLE_NAME
'geom', -- COLUMN_NAME
SDO_DIM_ARRAY -- DIMINFO attribute for storing dimension bounds, 0.5 m as 
tolerance
(SDO_DIM_ELEMENT ('LONGITUDE', -180, 180, 0.5 ),
 SDO_DIM_ELEMENT ( 'LATITUDE', -90, 90, 0.5 )), 
4326 -- SRID value for specifying a geodetic coordinate system
);
COMMIT;

4. Create a spatial index on the SDO_GEOMETRY column.

CREATE INDEX affected_regions_sidx ON affected_regions(geom) INDEXTYPE IS 
MDSYS.SPATIAL_INDEX_V2;

5. Create a dataset in Spatial Studio from the database schema used in the preceding steps.

The required target dataset is created. You may use this data layer on to which you can
apply the newly created custom map regions.

About Wind Animation
You can create and visualize wind animations that depict the direction of flow between various
locations.

Although commonly referred to as wind animation, this visualization applies for any movement-
based visualization. For instance, it can be used to render wind speeds, depict tectonic plate
movements, or other vector-based simulations. The following figure shows a sample wind
animation in Spatial Studio:
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These visualizations rely on wind velocities along the x (u) and y (v) axes as input. These
velocities are encoded within an image, where the red (R) and green (G) channels represent
the x and y velocities, respectively. The values are scaled and mapped to an integer range of
0–255, with the R channel holding the u velocities and the G channel holding the v velocities.

The base image thus serves as a grid of u and v velocities at each integral longitude and
latitude point within the specified bounding box (bbox). With this setup, the visualization
generates random particles on the map, which are then animated according to the wind
velocities, creating dynamic flowing visuals.

The following shows a sample base image that can be used to create a wind animation:
 

 

The base image for the wind animation can be generated from a NOAA dataset or from any
other supported data providers (see Generate a Base Wind Image From a NOAA Dataset for
an example). You can then load this image as GeoRaster to Oracle Database and create a
wind animation dataset for visualization.

Generate a Base Wind Image From a NOAA Dataset
This section provides the steps for generating a base wind image using a NOAA provider.

You can generate a base image for creating a wind animation dataset from the NOAA GFS
Dataset website or programmatically through scripts.

1. Open the URL NOAA GFS Dataset in your browser.

2. Select a Subdirectory for any specified data and time and proceed to the atmos option to
work with atmospheric data.

3. Set the file type to gfs.t06z.pgrb2.1p00.f000.

4. Select the layer type as 10m above the ground.

5. Select the UGRD (U-component of wind, eastward velocity) variable, specify the bounding
box (bbox) you wish to analyze, and then click Start Download.

6. Repeat the previous step for VGRD (V-component of wind, northward velocity).

Note that the velocity grids are downloaded as GRIB files.

7. Parse to extract the grid values from these files using GRIB tools (for example, wgrib2).

8. Create the base image by combining the grid values for UGRD and VGRD.

Note the following for creating the base image:

• The R (Red) channel represents UGRD (x-axis velocities).

• The G (Green) channel represents VGRD (y-axis velocities).
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• The velocity values must be scaled to fit within the 0-255 range, where umin, umax,
vmin, and vmax represent the minimum and maximum values for the u (x-axis) and v
(y-axis) velocities.
These minimum and maximum values are crucial for encoding and decoding the
velocity values from the base image, as they will be scaled to fit the 0-255 range for
visualization purposes.

Note

It is important that you note the data range values as these will be required to
create the wind animation dataset for the first time in Spatial Studio.

Alternatively, you can generate the base wind image programmatically through code as
shown in the following example scripts.
The following scripts describe the steps for downloading, parsing grid values, and finally
writing them into an image format for use in visualization.

download.sh

#!/bin/bash
 
GFS_DATE="20240719"
GFS_TIME="00"; # 00, 06, 12, 18
RES="1p00" # 0p25, 0p50 or 1p00
BBOX="leftlon=0&rightlon=360&toplat=90&bottomlat=-90"
LEVEL="lev_10_m_above_ground=on"
GFS_URL="https://nomads.ncep.noaa.gov/cgi-bin/filter_gfs_${RES}.pl?
dir=%2Fgfs.${GFS_DATE}%2F${GFS_TIME}
%2Fatmos&file=gfs.t06z.pgrb2.1p00.f000&${LEVEL}=on&subregion=${BBOX}"
curl "${GFS_URL}&var_UGRD=on" -o utmp.grib
curl "${GFS_URL}&var_VGRD=on" -o vtmp.grib
 
grib_set -r -s packingType=grid_simple utmp.grib utmp_out.grib
grib_set -r -s packingType=grid_simple vtmp.grib vtmp_out.grib
 
printf "{\"u\":`grib_dump -j utmp_out.grib`,\"v\":`grib_dump -j 
vtmp_out.grib`}" > tmp.json
 
rm utmp.grib vtmp.grib utmp_out.grib vtmp_out.grib
 
DIR=`dirname $0`
node ${DIR}/prepare.js ${1}/${GFS_DATE}${GFS_TIME}

prepare.js

const PNG = require('pngjs').PNG;
const fs = require('fs');
 
const data = JSON.parse(fs.readFileSync('tmp.json'));
const name = process.argv[2];
const umessage = data.u.messages[0];
const vmessage = data.v.messages[0];
 
const unpack = (message) =>
    message.reduce((acc, { key, value }) => ({ ...acc, [key]: value }), 
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{});
const u = unpack(umessage);
const v = unpack(vmessage);
 
const width = u.Ni;
const height = u.Nj;
 
console.log(`Width: ${width}, Height: ${height}`);
console.log(`u: min=${u.minimum}, max=${u.maximum}`);
console.log(`v: min=${v.minimum}, max=${v.maximum}`);
console.log(`u values length: ${u.values.length}, v values length: $
{v.values.length}`);
 
const png = new PNG({
    colorType: 2,
    filterType: 4,
    width: width,
    height: height
});
 
for (let y = 0; y < height; y++) {
    for (let x = 0; x < width; x++) {
        const i = (y * width + x) * 4;
        const k = y * width + x;
 
        if (k < 0 || k >= u.values.length || k >= v.values.length) {
            console.error(`Index out of bounds at (x: ${x}, y: ${y}) -> 
k: ${k}`);
            continue;
        }
 
        const uValue = u.values[k];
        const vValue = v.values[k];
 
        if (isNaN(uValue) || isNaN(vValue)) {
            console.error(`Invalid value at (x: ${x}, y: ${y}) -> u: $
{uValue}, v: ${vValue}`);
            continue;
        }
 
        png.data[i + 0] = Math.floor(255 * (uValue - u.minimum) / 
(u.maximum - u.minimum));
        png.data[i + 1] = Math.floor(255 * (vValue - v.minimum) / 
(v.maximum - v.minimum));
        png.data[i + 2] = 0;
        png.data[i + 3] = 255;
    }
}
 
png.pack().pipe(fs.createWriteStream(`/Users/user1/Downloads/build/$
{name}.png`));
 
fs.writeFileSync(`/Users/user1/Downloads/build/${name}.json`, 
JSON.stringify({
    source: 'http://nomads.ncep.noaa.gov',
    date: formatDate(u.dataDate + '', u.dataTime),
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    width: width,
    height: height,
    uMin: u.minimum,
    uMax: u.maximum,
    vMin: v.minimum,
    vMax: v.maximum
}, null, 2) + '\n');
 
function formatDate(dateStr, timeStr) {
    const year = dateStr.slice(0, 4);
    const month = dateStr.slice(4, 6);
    const day = dateStr.slice(6, 8);
    const hour = String(timeStr).padStart(4, '0');
    return `${year}-${month}-${day}T${hour.slice(0, 2)}:00:00Z`;
}

Visualize a Wind Animation Dataset
You can create a wind animation visualization in Spatial Studio.

The following instructions assume that you have a wind animation enabled GeoRaster dataset
and the dataset is already added to the project in the Active Project page. See Create a Wind
Animation Dataset and Enable Wind Animation For an Existing GeoRaster Dataset for more
information.

1. Click the Visualizations tab on the left pane in the Active Project page.

This lists the various visualization options.

2. Click and drag Map from the list to the visualization window on the right to create a map
visualization.

A default base map is displayed with no data visualization layers.

3. Click the Data tab on the left pane in the Active Project page.

This lists all the Datasets that are loaded for the project.

4. Click and drag the desired wind animation dataset from the list to the map view on the
right.

The wind animation visualization gets displayed as shown:
 

 

Legend using a color scheme is supported for wind animations. However, pitch and
rotation actions are not supported. If the view is rotated or pitched, then the wind animation
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will be disabled, and a warning will be displayed. The wind animation will automatically be
reenabled once the pitch/rotate is returned to the default (0).

5. Optionally, click  against the wind animation dataset layer in the Data tab of the Layers
list and configure the following properties.

• Number of Particles: Controls how many particles are randomly drawn in the current
viewport. These particles will be animated based on the wind velocities.

• Speed Factor: A multiplier between zero and one that adjusts the on-screen
movement in relation to the actual wind speed.

• Fade Opacity: Manages the length of particle trails and when they should fade out,
affecting the smoothness of the animation.

• Set palette: Sets the color scheme for different ranges of wind velocity.

Configure a Map Visualization
Learn how to configure the settings for your map visualization.

You can configure the map visualization settings, by clicking  , the Settings icon in the map
tool bar.
The Visualization Settings dialog opens with the default configuration values as shown as
shown:
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Spatial Studio supports the configuration of the following values:

• Viz label: You can define the label for your map visualization.

• Wraparound east-west: By default, the map is continuous, that is, the map displayed for
visualization is east-west wrap around. You can choose to disable this option if you prefer
to display the map in a non-repeating mode.

• Show legend: The legend displays the map layers that are used in the visualization.

• Legend Position: This determines where the legend gets displayed on the map.

• Navigation Bar: This displays zoom and compass controls on the map.
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• Show minimap: You can enable this option if you want to view an overview of the main
map as an inset within the main map.

• Show scale: You can enable this option if you want to configure a specific scale for the
map.

• Unit of map scale: Supported scale types are:

– Imperial

– Metric

– Nautical

• Show tile boundaries: You can switch ON this toggle to view the vector tile boundaries on
the map. The current map zoom level and tile column and row number are displayed for
each visible tile. This is mostly used as an information tool for debugging map rendering
issues.

• Show timeline: By enabling this slider, you can display the Timeline on the map.

• Basemap Language: This option appears only if you are using one of the three built-in
MapTiler vector basemaps as a map background. You can then set the language for your
basemap.

Filter Data on a Map Layer
You can filter on an attribute column of a dataset to determine the data points that must be
displayed on a map visualization.

The following steps enable you to add a data filter on a map layer.

The instructions assume that a map layer is displayed on your Active Project page.

1. Click  against the map layer in the Layers tab of the Layers List.

2. Select Settings in the context menu.

3. Select Filter from the Configure drop-down list as shown.

 

 

4. Select the Column name against which you want to filter data.
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5. Select the Operator and enter the data Value.

6. Optionally, select Apply on the server checkbox if you wish to filter the data at the server
side.

If Apply on the server option is not checked, then the filter is applied instantly on the
client and only on the data that is currently displayed on the map. It is important to note
that if the source table contains large amount of data, then Spatial Studio may not always
bring all the data to the visualization client. Therefore, the client-side filter may not be able
to find an item that should be there but is not displayed (due to server performing
automatically data sampling when generating vector tiles).

However, server side filter always queries the source table with the filter condition and
brings the filtered result to the client for display.

7. Click Apply.

The data points on the map layer are filtered as per the column filter.

Add Interactions to a Map Visualization
You can enhance your map interaction by configuring tooltips and info windows for the map
layers used in the map visualization.

Spatial Studio supports the following interactive features:

• Tooltip: A tooltip is shown when you hover over a location on your map and displays the
specified attribute information.

• Info Window An info window (popup window) displays the configured information for one
or more map layers at a given location or shape on your map.

Configure and View a Tooltip
Perform the following steps to configure a tooltip.

The instructions assume that you have a map layer displayed on your Active Project page.

1. Click  against the map layer in the Layers tab of the Layers List.

2. Select Settings in the context menu.

3. Select the Interaction option from the Configure drop-down list.

4. Enable Show tooltip under Tooltip.

5. Select a Tooltip column.

6. Hover over a specific data point or shape on your map to view the tooltip information.
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Configure and View a Tooltip
Perform the following steps to configure a tooltip.

The instructions assume that you have a map layer displayed on your Active Project page.

1. Click  against the map layer in the Layers tab of the Layers List.

2. Select Settings in the context menu.

3. Select the Interaction option from the Configure drop-down list.

4. Enable Show tooltip under Tooltip.

5. Select a Tooltip column.

6. Hover over a specific data point or shape on your map to view the tooltip information.

Changing the Pitch and Bearing of a Map
You can set the pitch and bearing of a map by tilting or rotating your map in the map
visualization panel.
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1. Navigate to the Active Project page where the desired project is displayed.

2. Click and drag the right mouse button if you wish to tilt the map.

3. Click and rotate the right mouse button if you wish to rotate the map.

The following example shows a tilted and rotated map:

Figure 8-1    Tilting and Rotating of a Map

4. Optionally, click Save to save the project with the new pitch and bearing settings.

Search Locations and Features on a Map
Using the Search option, you can quickly find locations and features on a map.

1. Click  in the map tool bar to search on the map.

2. Select one of the following option to perform the search.

• Search by Locations

a. Click Address or Longitude, Latitude in the search drop-down list.

b. Enter Address or place name, or alternatively, enter Longitude and Latitude to
search.
Note that as you enter the address (or place name), suggestions more relevant to
your search are displayed first.

c. Select the required suggestion from the list if you entered Address or place name
in the preceding step.
Spatial Studio drops a pin and zooms to the location of the search result.

• Search by Feature ID
A feature is a geometry object (point, line, or polygon type) on the map.

a. Click Feature in the search drop-down list.

b. Enter the complete ID of the feature in the search input box.
Note the following:

– The feature ID is identified by the key property column value of the specific
feature in its dataset.

– The search key is not case sensitive.

– You must enter the complete feature key to find the feature on the map.
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c. Click Search.
If the feature is found, Spatial Studio displays the feature ID and the dataset name
in the selection box.

d. Select the feature in the selection box.
Spatial Studio performs a search on the source data table and displays the search
results on a separate map layer as shown:
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9
Style a Map Layer

Spatial Studio allows you to explore different styling options for your map layers, in order to
enhance visualization and analysis.

The styling options provided to you may vary depending on the type of data you are mapping.

Topics:

• Apply a Render Style For a Point Layer

• Apply Style for a GeoRaster Layer

• Apply Data-Driven Style to a Map with H3 Aggregations

• Apply Predefined Colors to a Map Layer

• Apply Predefined Symbols to a Map Layer

• Apply Predefined Colors to Symbols

• Apply Custom Map Symbols to a Map Layer

• Apply an Animated Map Symbol to a Map Layer

• Apply Style to a Map Layer Using a GeoJSON URL Dataset

• Set Selection Tolerance on a Map Layer

• Add a Pin on a Map

• Apply Map Backgrounds

• Use the Redline Map Tool

Apply a Render Style For a Point Layer
You can render a point map layer using one of the following render style options:

• Circle (default)

• Symbol

• Heatmap

• Cluster

The following steps enable you to apply your preferred render style option.

The instructions assume that you have point map layer displayed on your Active Project page.

1. Click  against the map layer in the Layers tab of the Layers List.

2. Select Settings in the context menu.

3. Configure Style and select a Render Style option from the drop-down list.

By default, a point map layer always uses Circle to represent the data points.
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Note

Each render style has its own settings.

• If you select Cluster as the render style option, the data points on your map are shown
clustered depending on the cluster circle size.

Optionally, you can change the color and the style of the text labels representing the
number of points in each cluster.

• If you select Heatmap as the render style option, the data points on your map are
rendered with continuous colors based on the concentration of points as shown:

Note

Hot colors represent concentration of points, and cool colors represent
sparsity of points.
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Also, you can further customize the Heatmap visualization by changing the Radius or
Weight (or both) in the Basic settings panel shown in the preceding figure. The
following describes more about these parameters:

– Radius: This value defines (in pixel) how far each data point contributes to
(influences) the heat of its surrounding area. Its contribution drops to zero for any
area beyond this radius with the data point at the center.

– Weight: This value defines how much weight a data point contributes to the heat.
The default value is set to 1 which means all data points contribute equally to the
heat. If you select a numeric column (with zero or positive values) in the Weight
drop down list, then that value determines the weight contributed by a data point to
the heat calculation. For instance, if a data point’s weight column has a value of 5,
then it is contributing to the heat as if there are five data points at that location
(each with the default weight of 1). However, if the weight column contains a
negative value, then note that the result is not predictable.

– Intensity: This value should always be 1.

Tip

It is recommended that you reduce the default value of the Radius parameter
to observe a more localized view of point concentrations.

• If you select Symbol as the render style option, the data points on your map are
rendered with your chosen symbol as shown:

Tip

You can optionally select a color for your symbol.
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You can customize the symbol used to represent the data points by clicking the image
button next to the Symbol drop-down list. Spatial Studio provides several built-in sets
of symbols and also supports custom map symbols (icons).

See Also

– Apply Predefined Symbols to a Map Layer

– Apply Custom Map Symbols to a Map Layer

The map layer gets rendered with the appropriate style.

Apply Style for a GeoRaster Layer
You can style a GeoRaster map layer using the following steps.

The instructions assume that you have a GeoRaster map layer displayed on your Active
Project page.

1. Click  against the dataset in the Data tab of the Layers list.

2. Select Settings in the context menu.

The Layer Settings panel opens.

3. Optionally, modify any of the following options in the Style:

• Opacity

• Maximum Brightness

• Minimum Brightness

• Saturation

• Contrast

• Hue Rotate

• Fade Duration

4. Optionally, modify any of the following rendering options in the Raster tab:
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• Bands: Spatial Studio, by default supports the following bands:

– Red

– Blue

– Green

– Alpha

For GeoRaster images that have more than three layers, you can choose which three
layers you want to visualize.

• Resampling: The following two types of resampling processes are supported:

– Image Reprojection: This represents the interpolation method to be used when
transforming an image from one SRS (Spatial Reference System) to another. This
applies only if the SRS of the source image in the database table is different from
Spatial Studio's base map projection.

– Map Image Tile Generation: This represents the image interpolation value that
determines how each image cell's value on a view port is interpolated using the
original image pixels. During an image tile generation, resampling occurs (although
the provided images are in the same SRS) as the spatial resolution of the two
images may be different.
The following interpolation algorithm options are supported:

* NEAREST NEIGHBOR: This option has no interpolation by taking the nearest
image pixel's value directly.

* BI-LINEAR: This option will consider 4 neighboring pixels to determine the
image cell's value.

* CUBIC: This option uses cubic convolution function to estimate image cell's
value. Since a 4x4 neighboring pixels participate in the interpolation, it results
in a smoother image.
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• Image Processing: represents the subprogram to be used to enhance the visual
quality of the images.
You can choose the Terrain RGB algorithm and enable the Use as terrain toggle to
render GeoRaster images with GeoRaster Digital Elevation Model (DEM) data as 3D
terrains on the map.

The GeoRaster map layer is rendered with the updated settings.

Apply Data-Driven Style to a Map with H3 Aggregations
You can apply different resolutions to your H3 map layer to enhance your visualization.

In case of an H3 aggregation dataset, the hexagonal cells and the distribution of points in
these hexagons automatically change at each resolution level, as you zoom in and out of the
map. This implies that the color bins for one level might not be the same as for another level.

Spatial Studio provides an option to automatically calculate color bins as you alter your
resolutions. You can also turn this option off if you want to test against a set of specific
thresholds.

The following steps enable you to apply a data-driven styling option for your H3 map layer.

The instructions assume that you have a H3 map layer displayed on your Active Project page.

1. Click  against the map layer in the Layers tab of the Layers List list.

2. Select Settings in the context menu.

3. Configure Style.

4. Select Based on Data for the Color value under Fill.

The Style details panel is displayed.

5. Select the Column to control styling.

6. Switch on or off the Automatically adjust bin values toggle button.

• If turned on, the bin values will automatically update as you zoom in or out on the map.

• If turned off, Create value bins option appears.

7. Assign colors to the bins based on data values.

The following figure shows the Style details panel options:
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The color bins on the H3 map layer gets rendered appropriately for different resolutions as
shown in the preceding figure.

Apply Predefined Colors to a Map Layer
Using a column with predefined color codes or values, you can create accurate and consistent
choropleth map layers.

You can store a color-coded value in a column of your dataset and then use this column
property to color code your map.

The following steps enable you to color code your map layer.

The instructions assume that the map layer displayed on your Active Project page uses a
dataset having a column property that contains color-coded values.

1. Click  against the map layer in the Layers tab of the Layers List.

2. Select Settings in the context menu.

3. Configure Style by selecting Column with color codes for the Color value under Fill.

4. Select the Column that contains the color value.

The following figure shows the styling of the map layer using the color variable in the
dataset:
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The color code gets applied to the map layer.

Apply Predefined Symbols to a Map Layer
Using a column with predefined symbol values, you can apply data-driven symbol styling to
your map layer.

However, the symbol must belong to one of the supported symbol sets. Symbols in Spatial
Studio are grouped into three sets and each set is identified by a Symbol set id as described
in the following table:

Table 9-1    Symbol Set

Symbol Set Symbol set id

Spatial Studio default studio

Oracle Redwood symbols oracle-redwood-symbols

Airfields airfields

You can store a symbol name and the symbol set to which it belongs in a column of your
dataset and then use this column property to assign symbols to your map.

For example, assume you want to use the airport icon as shown in the following figure:
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You must then use oracle-redwood-symbols/airport as the symbol name in your dataset
column. In this case:

• oracle-redwood-symbols: is the symbol set id

• airport: is the name for the icon to be used on the map layer

The following steps enable you to apply data driven symbol styling for your map layer.

The instructions assume that the map layer displayed on your Active Project page uses a
dataset having a column property that contains symbol names following the convention as
explained earlier in this section.

1. Click  against the map layer in the Layers tab of the Layers list.

2. Select Settings in the context menu.

3. Configure Style and select Symbol as the Render Style.

4. Select Column with symbol names from the Symbol drop-down list in the Basic section
of the Symbol tab.

5. Select the Column that contains the symbol name value.

The following figure shows the styling of the map layer using the symbol name variables in
the dataset:

Note

If incorrect symbol names are present in the dataset column, then for those data
points, the Default symbol is displayed on the map layer.

Chapter 9
Apply Predefined Symbols to a Map Layer

Using Oracle Spatial Studio on Autonomous AI Database
G40399-01
Copyright © 2021, 2026, Oracle and/or its affiliates.

April 10, 2026
Page 9 of 19



The symbols gets applied to the map layer.

Apply Predefined Colors to Symbols
You can color the symbols on a map layer by using an attribute column of the dataset that
contains predefined color codes.

The following steps enable you to color code the symbols on a map layer.

The instructions assume that the map layer displayed on your Active Project page uses a
dataset having a column property that contains color-coded values.

1. Click  against the map layer in the Layers tab of the Layers List.

2. Select Settings in the context menu.

3. Configure Style by selecting Column with color codes for the Color value in the Basic
panel.

4. Select the Column that contains the color value.

Note that the color values in the column must be in #RGB notation with the # character
included.

The color code gets applied to the symbols on the map layer. The following figure shows
the color-coded symbols on the map layer using the color variable in the dataset:
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Apply Custom Map Symbols to a Map Layer
You can apply custom map symbols for styling your map layer.

However, note that if a point dataset is being styled by custom symbols, then it can no longer
use any of the built-in symbols. Essentially, you cannot mix both custom and built-in symbols
on a map layer in the map visualization.

Perform the following steps to style your map layer using custom map symbols.

The instructions assume that a map layer is displayed on the Active Project page and the
custom map symbols are already added in Spatial Studio. See Upload a Map Symbol for more
information.

1. Click  against the map layer in the Layers tab of the Layers list.

2. Select Settings in the context menu.

3. Configure Style and select Symbol as the Render Style.

4. Click the image button next to the Symbol drop-down list.

The Symbol set drop-down appears.

5. Select Custom under Custom symbols in the Symbol set drop-down list.

The uploaded custom symbols list appears.

6. Select the required custom symbol.

The symbol gets applied to the map layer as shown in the following figure:
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Apply an Animated Map Symbol to a Map Layer
You can apply a circular animating (pulsing) symbol for styling point-type map layers.

Perform the following steps to apply an animating symbol to a map layer.

The instructions assume that a point map layer is already displayed on the map.
The new animating symbol is found in the Symbol render style or symbol picker.

1. Click  against the map layer in the Layers tab of the Layers list.

2. Select Settings in the context menu.

3. Configure Style and select Symbol as the Render Style.

4. Click the image button next to the Symbol drop-down list.

The Symbol set drop-down appears.

5. Select the pulsing-dot symbol under the Animations section in the Symbol set drop-down
list.

6. Optionally, customize the animating symbol.

This includes the overall Icon size, Inner circle color, Outer circle color, Stroke, and
Opacity of the inner circle. Also, you can customize the animation speed by configuring
the Duration in ms field.

The following figure shows custom styling of an animated symbol on a map visualization.
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Apply Style to a Map Layer Using a GeoJSON URL Dataset
Spatial Studio supports data-driven styling for your GeoJSON URL dataset map layer. You can
access the dataset columns that are sourced from the source URL and apply the desired
styling for the map layer.

See Also

Create a GeoJSON URL Dataset

The instructions assume that you have added a GeoJSON URL dataset on your Active Project
page.

1. Click  against the map layer in the Layers tab of the Layers List list.

2. Select Settings in the context menu.

3. Configure Style.

4. Apply the radius or color styling based on data columns.
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• Styling based on data

a. Select Based on Data in the Radius or Color drop down list.

b. Click the Edit bind icon.

c. Select the Column to control styling.

d. Optionally, adjust the bin and the output values.

• Applying predefined colors

a. Select Column with color codes in the Color drop down list.

b. Select the Column.

The following figure shows the radius and color styling applied to a GeoJSON URL dataset
map layer:

Set Selection Tolerance on a Map Layer
Spatial Studio allows you to increase or decrease the selection tolerance on a map layer, so
that selecting small and linear geometry features is easier.

The following steps enable you to adjust and set the selection tolerance on a map.

The instructions assume that a project is open on the Active Project page.

1. Click  against the dataset in the Data tab of the Layers list.

2. Select Settings in the context menu and configure Interaction.

3. Switch on the Allow selection toggle button.

4. Adjust the Selection tolerance slider as required.
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The following figure shows the Selection section for setting the tolerance:

The custom selection tolerance gets applied to the map layer.

Add a Pin on a Map
The following steps enable you to inspect the current mouse pointer's latitude and longitude
coordinates and pin a location on the map layer.

The instructions assume that you have a project opened on your Active Project page and the
map layer is displayed for visualization.

1. Right-click on any area on the map layer.

The coordinates for the location gets displayed as shown:

2. Click Drop a pin to add a location marker.

The pin gets displayed on the map. Additionally, you can also copy the coordinates by
clicking on the marker and then clicking the Longitude, Latitude: click to copy icon.
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Apply Map Backgrounds
Spatial Studio provides ready-to-use map backgrounds to enhance your visualization.

You can select one of the following map backgrounds for your project visualization:

• MapTiler Vector Basemaps

• Oracle Raster Basemaps

• Blank Basemaps

• User-defined Basemaps

As an administrator, you can also register custom basemaps and use them in map
visualizations. They may be raster or vector tiles that are typically hosted on third party
servers, or they be created using a WMS OGC web service. See Add a Custom Basemap for
more information.

The labels on the the basemap are displayed in English along with the local language of the
region. However, you can change the language for the basemap labels. See Configure a Map
Visualization for more information.

 

 
The following section describes how to apply a specific map background for your project:

Change Map Backgrounds
The following steps enable you to apply different map backgrounds in your project
visualization.

The instructions assume that you have a project opened on your Active Project page.

1. Click  in the Background tab of the Layers list.

2. Select Settings in the context menu.

3. Click the Change the Background Map Style drop-down and select your required
background map as shown.
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All custom basemaps appear under User-defined Basemaps in the drop-down list.

The selected map background gets applied to your project visualization.

Use the Redline Map Tool
Spatial Studio provides the Redline map tool for drawing and annotating different geometry
shapes on your map.

In addition, you can edit, delete, or share these redline drawing sets by exporting it to a
GeoJSON file.

Perform the following steps to get started with the Redline map tool. The instructions assume
that you have a project opened on your Active Project page and the map layer is displayed for
visualization.

1. Click the Actions icon on the map tool bar and select Redline.

Alternatively, right-click on the map layer and select Show redline toolbar.
The Redline map tool bar appears as shown:

The tool bar provides the following options for defining or managing Redline objects on the
map:

• Select Feature (default): To select a Redline object for update or delete.

• Draw Point: To define a Redline point.

• Draw Line: To define a Redline line.

• Draw Polygon: To define a Redline polygon.

• Draw Rectangle: To define a Redline rectangle.

• Draw Circle: To define a Redline circle.

• Draw Freehand: To draw a Redline freehand.

• Click to choose a color: To choose the default color for the Redline objects.
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• Export Features: To export the Redline objects to a GeoJSON file. You can later
upload the file to create a Dataset which can be used in Map Visualizations. See 
Create a Dataset by Uploading a File to upload a GeoJSON file.

• Toggle Visibility: To hide or unhide the marked Redline objects.

2. Click the desired drawing option and draw the corresponding shape on the map.

For example, the following figure shows three Redline objects added to a map layer:

Repeat this step to add as many Redline objects as required.

Tip

You can duplicate and move a Redline object on the map.

3. Optionally, perform any of the following actions on a defined Redline object.

• Modify the Shape of the Redline Object

a. Click Select Feature on the Redline map toolbar.

b. Click the required Redline object.
The existing vertices of the object are shown highlighted in red.

c. Click along the object boundary to add new vertices (points) and adjust its shape
as required.

d. Optionally, move the entire object to the desired location on the map.

• Edit Feature Properties

a. Click Select Feature on the Redline map toolbar.

b. Right-click and select Edit Feature Properties on the required Redline object.

c. Add a Description to annotate the object.
This description will be displayed as a tooltip when you mouse over a Redline
object.

d. Optionally, modify the Fill and Outline width.

• Duplicate Feature

a. Click Select Feature on the Redline map toolbar.
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b. Right-click and select Duplicate Feature on the required Redline object.

c. Move the duplicated object to the desired area on the map.

• Delete Feature

a. Click Select Feature on the Redline map toolbar.

b. Right-click and select Delete Feature on the required Redline object to be deleted.

Also, note that the following keyboard shortcuts are supported when working with Redline
objects:

• Click esc to deselect the currently selected feature.

• Click del to delete the currently selected feature.

• Click ctrl + r and drag to rotate the currently selected feature.

• Click ctrl + s and drag to scale or resize the currently selected feature.

4. Optionally, export all the marked Redline objects to a GeoJSON file.

a. Click Export Features on the Redline map toolbar.

b. Click Download as GeoJson and save the .geojson file to your system.

Also, note the following details regarding the exported GeoJSON file:

• Each Redline object is automatically assigned a unique ID (UUID), which will be a
exported.

• Any description entered for a Redline object is exported.

• Any styling information, such as custom colors and outline width are NOT
exported.

5. Click Save to save your project with the Redline drawings.

The drawings will be persisted as a part of the project. Note that when you reopen an
existing project with Redline drawings, the shapes are initially not editable. You must select
the Redline tool again to "rehydrate" the tool with the drawings.

6. Close the Redline map tool by clicking the Actions icon on the map tool bar and selecting
Redline.
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10
Run Spatial Analyses

You can perform various spatial analyses (such as filtering by proximity, nearest neighbor
analysis and so on) and visualize the results in Spatial Studio.

These spatial analyses are grouped under the following categories in Spatial Studio:

• Filter

• Combine

• Transform

• Measure

• Analytics

The following topics explore a few spatial analysis operations:

Topics

• Create Lines to Connect Latitude/Longitude Pairs

• Create an Isochrone Map for Analysis

• Determine the N-Nearest Geometries

• Determine Geometries Within a Specified Distance

• Determine the Geometries Filtered By Non-Spatial Attributes

• Determine the Size of Geometries

• Densify Geometry Analysis

• Find the Shortest and Quickest Route
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• Summarize By Region Analysis

Create Lines to Connect Latitude/Longitude Pairs
The Create lines from start/end points transform operation creates a line connecting two
pairs of latitude and longitude coordinates on a map layer.

To perform this transformation analysis, ensure that a dataset comprising two pairs of latitude
and longitude coordinates (one represents the starting points and the other, ending points) in
each row is added in the Active Project page. The Create lines from start/end points
analysis takes the column names of these two pairs of latitude and longitude coordinates as
input and generates the line geometry connecting the starting and ending points.

Perform the following steps to run the Create lines from start/end points spatial analysis.

1. Click  against the map layer whose coordinates needs to be filtered in the Layers tab.

2. Select Spatial Analysis.

The Spatial Analysis Operations slider opens.

3. Click the Transform tab and select Create lines from start/end points.

Create lines from start/end points slider opens as shown:

4. Optionally, modify the resulting datasets name in Results dataset.

5. Select the Start longitude column.

6. Select the Start latitude column.

7. Select the End longitude column.

8. Select the End latitude column.
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9. Optionally, switch ON the Display as linestrings representing arcs on the Earth's
surface toggle.

This factor takes into consideration that the earth is spherical and accordingly projects the
connecting line between the two sets of coordinates on the map layer. It is very useful for
large distances between two coordinates and it is recommended that you use this option.

10. Optionally, modify the Distance between vertices in resulting linestring (in meters)
(only if you have included the Display as linestrings representing arcs on the Earth's
surface option in the preceding step).

11. Click Run.

The Analysis results are listed under Analyses in the Data elements panel on the left pane
of the Active Project page.

12. Drag and drop the following layers on the map - starting points, ending points, and finally
the GEOMETRY (that connects the starting and ending points) analysis on the map view.

The following figure shows an example of the Create lines from start/end points spatial
analysis:

Create an Isochrone Map for Analysis
You can create isochrone (driving-time) polygons, which show the areas that can be reached
within a specified distance or time, for a set of input locations.

Perform the following steps to run the Driving reach spatial analysis.

1. Click  against the map layer, which contains the input locations, in the Layers tab.

2. Select Spatial Analysis.

The Spatial Analysis Operations slider opens.

3. Click the Analytics tab and select Driving reach.

Calculate drive time/distance polygons slider opens as shown:
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4. Optionally, modify the resulting dataset name in Results dataset.

5. Specify the input geometries from the Calculate polygon from drop-down.

You can choose one of the following options:

• Point geometries: Select the specific input geometry column of the dataset.

• Input coordinates: Enter manually the Longitude and Latitude coordinates.

• Pins on the map: This option appears if you have one or more pins created on the
map.

6. Specify the Reach distance or time as required.

7. Select the Unit for the specified Reach.

8. Optionally, modify the Geometry column name in which the resulting polygon geometries
will be stored.

9. Click Run.

The job to run the analysis gets initiated. Once the job completes, the Analysis result
dataset gets listed under Analyses in the Data elements panel on the left pane of the
Active Project page.

10. Drag and drop the geometry column from the Results dataset on the map view.

The following figure shows an example of Driving reach spatial analysis. The polygons
shows the areas that are within two hour reach from the input locations (shown in green).
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Determine the N-Nearest Geometries
Using the SDO_NN_V2 filter, you can determine the N-nearest geometries to a geometry.

To find the N-nearest geometries, you must perform the following steps.

The instructions assume that you have the layer to be filtered and the map layer to be used as
a filter displayed on your Active Project page.

1. Click  against the map layer, whose coordinates needs to be filtered, in the Layers tab.

2. Select Spatial Analysis.

The Spatial Analysis Operations slider opens.

3. Click on the Filter tab and select Return shapes nearest to another.

Nearest neighbors slider opens as shown:
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4. Enter Analysis name.

5. Select the Layer to be filtered.

Note

Ensure that you have run spatial validations on the map layer to be filtered and the
map layer to be used as the filter in order to obtain accurate analysis results.

6. Enter Number of results.

7. Click Run.

The Analysis result is listed under Analyses in the Data elements panel on the left pane of
the Active Project page.

8. Drag and drop the analysis result on the map view.

This creates a new map layer highlighting the N-nearest neighbor geometries for a
geometry.

Determine Geometries Within a Specified Distance
Using the SDO_WITHIN_DISTANCE filter, you can filter coordinates that are within a specific
distance from a point on the map layer.

To filter points based on this proximity filter, you must perform the following steps.

The instructions assume that you have the layer to be filtered and the map layer to be used as
a filter displayed on your Active Project page.
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1. Click  against the map layer whose coordinates needs to be filtered in the Layers tab.

2. Select Spatial Analysis.

The Spatial Analysis Operations slider opens.

3. Click on the Filter tab and select Return shapes within a specific distance of another.

Within distance slider opens as shown:

4. Enter Analysis name.

5. Select the Layer to be filtered.

6. Select the Layer to be used as the filter.

7. Enter distance and unit.

8. Click Run.

The Analysis result is listed under Analyses in the Data elements panel on the left pane of
the Active Project page.

9. Drag and drop the analysis result on the map view.

This creates a new map layer highlighting the filtered coordinates within a specific distance
from a point as shown:
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Determine the Geometries Filtered By Non-Spatial Attributes
You can perform non-spatial filter analysis using a compound query.

To run a compound query with non-spatial attributes, you must perform the following steps.

The instructions assume that you have the layer to be filtered displayed on your Active Project
page.

1. Click  against the map layer, whose coordinates needs to be filtered, in the Layers tab.

2. Select Spatial Analysis.

The Spatial Analysis Operations slider opens.

3. Click the Filter tab and select Return elements filtered by non-spatial rules.

The Attribute Filter slider opens as shown:
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4. Optionally, change the default Analysis name.

5. Optionally, change the Dataset to be filtered only if you want to apply the filter criteria
against a different dataset. In such a case, Spatial Studio removes any existing criteria
associated with the default dataset.

6. Select the Column name.

7. Select the Operator to filter by from the drop-down list.

8. Enter the Value to be filtered.

9. Optionally, click Add Criteria to repeat from step-6 to step-8 to add as many criteria as
required. Also, click the And or Or operator to form the compound query.

10. Click Run.
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The Analysis result is listed under Analyses in the Data elements panel on the left pane in
the Active Project page.

11. Drag and drop the analysis result on the map view.

This creates a new map layer highlighting the geometry for the filtered attributes.

Determine the Size of Geometries
You can run a spatial analysis to measure the size of the geometries on your map layer.

The analysis operation returns the size of the geometries in bytes. These values are stored in
a new dataset column. Perform the following steps to measure the size of the geometries.

The instructions assume that you have a dataset with point geometries displayed on your
Active Project page.

1. Click  against the map layer whose coordinates needs to be filtered in the Layers tab.

2. Select Spatial Analysis.

The Spatial Analysis Operations slider opens.

3. Click on the Measure tab and select Calculate geometry storage size in bytes.

A slider opens as shown:
 

 

4. Optionally, modify the Result Column Name.
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5. Select the Geometry Column from the drop-down list to compute the geometry size.

6. Click Run.

The Analysis result is added as a new column to the dataset in the Active Project page.
You can then interact with the map to view the size value through tool tip or info windows.
For example:
 

 

Densify Geometry Analysis
The Densify Geometry transform operation densifies the input geometry by adding more
points based on an interval value.

This analysis is useful when visualizing large distances between two coordinates.
To perform this analysis, ensure that a dataset comprising the input geometries (lines or
polygons) is added in the Active Project page.

Perform the following steps to run the Densify Geometry spatial analysis.

1. Click  against the map layer whose coordinates needs to be filtered in the Layers tab.

2. Select Spatial Analysis.

The Spatial Analysis Operations slider opens.

3. Click the Transform tab and select Densify Geometry.

Densify Geometry slider opens as shown:
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4. Optionally, modify the Results dataset name.

5. Select the Layer to be transformed.

6. Optionally, modify the Interval for densification.

If the interval is set to too small a value, then the densified geometry may contain a very
large number of vertices. This can cause an adverse effect on storage and performance
when visualizing or further analyzing them.

7. Click Run.

The Analysis results are listed under Analyses in the Data elements panel on the left pane
of the Active Project page.

8. Drag and drop the densified geometry column from the result dataset.

The following figure shows an example of the Densify Geometry spatial analysis.
Considering that the earth is spherical, the densified geometry (in green) is projected as a
curve.
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Find the Shortest and Quickest Route
Using the Driving route spatial analysis operation, you can find and store the shortest or
fastest driving route between two points.

The route analysis supports the following modes:

• Pairwise Routing: In this mode, each input dataset contains both the starting and ending
point geometries for the route.

• One-to-many Routing: In this mode, the route is determined between the starting point
geometries in the dataset to a single end point. This end point can be defined by one of the
following methods:

– Map Pins: You can previously pin a location on the map by directly adding a pin (Add
a Pin on a Map) or by using the search option (Search Locations and Features on a
Map).

– Input coordinates: You can manually provide the longitude and latitude coordinates
when configuring the route analysis.

Also, note the following:

• The route analysis can be performed only on datasets with point geometries.

• You can choose to include one or more of the following parameters in the resulting output:

– Route Geometry

– Distance

– Time

• The results of the analysis (route geometry, distance and (or) time) are stored directly into
the input dataset.

• The analysis can be used multiple times on the same dataset by specifying different
column names for storing the results.

Perform the following steps to run the Driving route spatial analysis.
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The instructions assume that you have a dataset with point geometries displayed on your
Active Project page and the destination pin is already placed on the map.

1. Click  against the map layer containing the starting point geometries for the route.

2. Select Spatial Analysis.

The Spatial Analysis Operations slider opens.

3. Click the Analytics tab and select Driving route.

Calculate driving route slider opens as shown:

4. Select the input dataset in the For each item in drop-down.

Note that this drop-down will only list datasets with point geometries that are added to the
project.

5. Select the destination end point in the Calculate Route to drop-down.

Note that this drop-down allows you to choose the end point against the following headers:

• Point geometry columns: Lists other point geometry columns in the input dataset.
This is primarily used for pairwise routing (from the start to the end points of each
feature in the same dataset).

• Map Pins: Lists the map pins that are already added on the map. See Add a Pin on a
Map and Search Locations and Features on a Map for more information on dropping a
location pin on the map.

• Input coordinates: Manually enter the longitude and latitude coordinates.

Using either map pins or input coordinates results in the routes being calculated from each
starting point geometry in the input dataset to a single end point.
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6. Select one or more of the following checkbox options and specify the corresponding
column name to store the results of the analysis.

• Time column

• Distance column

• Route column

Note that at least one of the preceding columns must be included in the results.

Optionally, select the Unit for Time and Distance columns.

7. Select the Route preference.

8. Click Run to run the analysis.

On completion, the input dataset gets updated with the extra columns chosen to store the
results.

The following figure shows the results of the shortest route analysis (from each input point
to the destination pin) on map visualization.

Summarize By Region Analysis
Spatial Studio supports descriptive analysis where you can obtain the summary of data points
(such as count, average, sum, minimum, and maximum) on a region based dataset.

To perform summarize by region analysis, you can perform the following steps.

The instructions assume that you have a point map layer displayed over a region map layer on
your Active Project page.

1. Click  against the map layer, whose coordinates needs to be filtered, in the Layers tab.

2. Select Spatial Analysis.

The Spatial Analysis Operations slider opens.

3. Click the Analytics tab and select Summarize By Region.

The Summarize by region slider opens as shown:
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4. Optionally, change the default name for the new analysis Results dataset.

5. Select the region based map dataset from the For each item in drop-down list.

6. Select the point map layer from the Summarize items in drop-down list.

7. Select the Summary option.

8. Optionally, change the Summary column name.

9. Click Run.

The Analysis result is listed under Analyses in the Data elements panel on the left pane in
the Active Project page.

10. Drag and drop the analysis result on a table or map visualization.

You can view the summary results as shown:
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